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Preface 1
Purpose of the manual:

In this manual, the operation and control of batches are described and you are given an 
overview of the following topics:

● Order system and its configuration

● Order list

● Batch list

● Batch monitoring

● System equipment list

● Units figure block (Faceplate)

● Control recipe display

● Batch operation diagnosis

This manual is intended for those responsible for configuring, commissioning and servicing 
automation systems.

Where is this manual valid?
This manual is valid for the software package BRAUMAT/SISTAR Classic  from Version V6.0.

The offered electronic manual is most largely identical to the contents of the on-line help. Due 
to a technically necessary editorial deadline for the generation of electronic manuals, small 
deviations can occasionally occur in relation to the on-line helps. The statements in the on-line 
helps take priority over those of the manual.

Place of this documentation in the information environment
This manual forms part of the BRAUMAT SISTAR Classic V6.0 documentation package. The 
following schematic of the document architecture shows the individual manuals as well as their 
thematic grouping within the entire program package

Operator control and monitoring of batches
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Further support
If you have any technical questions, please get in touch with your Siemens representative or 
agent responsible.

You will find your contact person at:

http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal) 

You will find a guide to the technical documentation offered for the individual SIMATIC Products 
and Systems here at:

http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal) 

The online catalog and order system is found under:

http://mall.automation.siemens.com/ (http://mall.automation.siemens.com/) 

Training Centers 
Siemens offers a number of training courses designed to familiarize you with the SIMATIC S7 
automation system. Please contact your regional training center or our central training center 
in D 90026 Nuremberg, Germany for details: 

Internet: http://www.sitrain.com (http://www.sitrain.com) 

Technical Support
You can reach the Technical Support for all A&D products

Via the Web form for the Support Request

http://www.siemens.com/automation/support-request (http://www.siemens.com/automation/
support-request) 

Additional information about our Technical Support can be found on the Internet pages http://
www.siemens.com/automation/service (http://www.siemens.com/automation/service) 

Service & Support on the Internet
In addition to our documentation, we offer our know-how online on the Internet at

http://www.siemens.com/automation/service&support (http://www.siemens.com/automation/
service&support) 

where you will find the following:

● The newsletter, which constantly provides you with up-to-date information on your products.

● The right documents via our Search function in Service & Support.

● A forum, where users and experts from all over the world exchange their experiences.

● Your local representative for Automation & Drives.

● Information on field service, repairs, spare parts and more under "Services".

Preface
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See also
http://www.siemens.com/automation/partner (http://www.siemens.com/automation/partner)
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Order system 2
2.1 General

Short description
The order system has the task of processing a list of batches in cooperation with the recipe 
control on the IOS and subordinated PCUs. This list can be created by the order system on 
the IOS or by a higher-level system (PMS) and the batch sequence and list content can be 
changed later. 

Furthermore, the order system makes it possible to track and monitor the processing of 
batches. 

The order system is included in the standard system. However, the usage of the order 
parameter isn't possible.

The usage of order parameters is supplied as an option.

It is started as "batch list" in the "Process monitoring" tab of the BRAUMAT / SISTAR Classic 
V6.0  main menu.

 

 Note

The order system and the recipe system share a common database that contains data such 
as recipe headers and similar items. After you modify a recipe (e.g. the header), you need to 
restart the batch list program in order to refresh the program with the data which were written 
to interim memory for reasons of performance.
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2.2 Functions

2.2.1 Order and recipe system redundancy
The following conditions must be fulfilled so that the redundancy of the order and recipe system 
works correctly:

● The recipe data must be stored redundantly.
In the file 'windcs\sys\sys.ini'  the section...
[Paths] 
Recipe=local path; path of the redundant computer must be entered, the first path must 
always be accessible by the IOS (this is the local hard disk as standard).

● The order data must be stored redundantly.
In the file 'windcs\sys\sys.ini'  the section...
[Paths] 
Bali=local path; path of the redundant computer must be entered, the first path must always 
be accessible by the IOS (this is the local hard disk as standard).

● The silo data must be stored redundantly (if available).
In the file 'windcs\sys\sys.ini'  the section...
[Paths] 
Silo=local path; path of the redundant computer must be entered, the first path must always 
be accessible by the IOS (this is the local hard disk as standard).

● By activating the recipe server, the application synchronization must run.

● At the time of the recipe server failure, the reserve recipe server must have been started.

● The startup as active recipe server must have been completed without any interruption.

2.2.2 Order types
● Up to 255 order types can be configured.

● There is a 1:1 relation between recipe category and order type

● One different list of order parameters can be configured per order type

● The adjustments for batch input, as well as order and batch number allocation can be set 
up for each order type specifically.

2.2.3 Batch list
● In one list, all planned and running batches are held.

● Ready batches are removed from the list.

● There is no limitation to the list. It should not exceed, however, the length of 1000 batches.

● The displayed columns can be configured.

● The status of the batches is displayed.

Order system
2.2 Functions
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● In the list, batch parameters can be displayed.

● The sequence of the batches in the list can be changed.

● The batches can have a line reference, if the recipe was configured as a line recipe.

● A global or order type-specific view can be selected.

● The start sequence depends on the start mode, the start time or the event. For 
simultaneously authorized starts, the batch that stands at the top of the list is started.

● The view is updated automatically in case of changes.

2.2.4 Order list
● In an order list, orders (batches with the same batch number) are displayed.

● The displayed dates are created from the batch list.

2.2.5 Batch monitoring
● In the view ‘batch monitoring’, the necessary batches of the list are displayed for all batches 

of the list.

● The status of the unit in reference to the batch is displayed in color.

● The batch monitoring displays the batch progress from the figures of the unit.

● In each line one batch is displayed with the units which have already finished, the running 
and following (conforming to the recipe) units (in different colors).

● In the list any further data for the batch can be displayed beside the units.

2.2.6 History
● In this view all finished batches are displayed.

● The start and end time of the batches are displayed

2.2.7 Start modes
 

● The following start modes are available: ‘as soon as possible’, ‘by event’, ‘after absolute 
time’, ‘after time with automatic adaptation’.

● The possible start modes can be configured order type-specific.

Order system
2.2 Functions
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2.2.7.1 ‘As soon as possible’
The batch is started as soon as the necessary start sequence is free, in the automatic mode, 
is not stopped and not disabled. For several batches that are enabled and waiting for the same 
sequence, the batch which is in the list at the uppermost end is started.

2.2.7.2 ‘by event’
The batch is loaded in the CAS block of the S7 as soon as this one is free. There, the system 
waits until a bit is set by the user in the data record CAS (Event). The bit has the name 
boFreeMode4 in the UDT 718. 

The sequence and therefore the batch is only started if the sequence is free.
 

 Note

Program engineering is responsible for the allocation of order and batch numbers when using 
this property. Charge processing may be unduly locked, due to an error which occurs when 
the batch process is started more than once with the same order and batch number.

The start of a batch production with a routing or line recipe is not possible in "event-triggered" 
startup mode, unless the batch was created by means of the batch list program, and the 
"ready" status was set. Otherwise, the system will not find the correct route or line number.

 

2.2.7.3 ‘After time’
The batch is started if the batch start time is reached or exceeded. The batch is only started 
if the CAS which is necessary for the sequence and the sequence are free.

2.2.7.4 ‘Automatic batch time adaptation’
The start occurs as with the start mode 'after time'. However, the start times of the sequence 
batches are adapted automatically by this start mode if delays occur during the start of the 
batch. The adaptation only occurs with this start mode and batches which have the same start 
sequence.

2.2.7.5 Manual change of start time/start mode
If the dialog in the order system in the batch list under ‘processing’-> ‘Change start time' is 
closed with OK, there will be the following procedure:

● Start mode: ‘As soon as possible’: 
No adaptation of different batches occurs.

● Start modes: 'After time' and 'after time with automatic adaptation': 
All subsequent batches with the mode 'after time/auto' are adapted to the start cycle.
For the first batch with the mode 'after time', the adaptation ends. Therefore, time gaps can 
be realized (e.g weekends).  
Batches with the mode 'as soon as possible' or state 'Ready to start', 'Started', 'Deleted' 
and 'Ready' are skipped.

Order system
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As soon as a batch goes into the state 'Started', this triggers a check on the start times of the 
remaining batches with the same start unit.

First the current time is entered as start time in the started batch.

Then all batches with the mode 'after time/auto' are adapted exactly to the start cycle.

In order to prevent continuous adaptation of start times after a batch start, a tolerance limit can 
be allocated by testing the start times.

The tolerance limit can be adjusted in the file bali.ini in the folder 'wincds\sys'  under [balidata] 
TimeCorrTolerance=60 .

TimeCorrTolerance=60  is the preset value (in seconds) and means that there is only a reaction 
if the start time will be under or exceeded by more than 60 seconds.

2.2.8 Batch states
 

● There are the following states: Disabled, enabled, ready to start, able to start, is running, 
ready, deleted, aborted and several error states

● The states are changed by operation, by messages of the PLC or via the sequence 
controller.

2.2.8.1 Conditions and transitions

Status Possible change to By
Disabled Ready Operation
 Enabled Operation
 Deleted Operation
   
Ready Disabled Operation
 Enabled Operation
 Deleted Operation
   
Enabled Disabled Operation
 Ready Operation
 Deleted Operation
 Ready-to-start Batch control
   
Ready-to-start Disabled Operation
 Deleted Operation
 Running PCU control
   
Running Aborted Operation
 Done Batch control

Order system
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Status Possible change to By
   
Error n Disabled Operation (if error corrected)
n = error number Ready Operation (if error corrected)
 Enabled Operation (if error corrected)
 Deleted Operation 
   
Done --- ---
   
Deleted --- ---
   
Aborted --- ---
   

 

Table 2-1 Meaning of error numbers in batch state:

Error 1 Recipe header could not be read.
Error 2 Conversion of the process input list failed.
Error 3 Process input list user function delivers FALSE
Error 4 Writing of batch status into bali.dbf  failed
Error 5 Loading of batch in the CAS of start batch failed
Error 6 no CAS copy for the batch
Error 7 no unit sequence for the batch
Error 8 Invalid batch values on enabling:

● Y<0 (Year)
● RT<=0 (Recipe type)
● ONr<=0 (order number)
● BNr<=0 (batch number)
● LNr.<=0 (Line number)

Error 9 For user function saves

Error 1: Recipe header could not be read.
Incomplete or incorrect recipe engineering is present on this machine.

Error 2: Handling of errors in the process input list
First, a check must be performed to ascertain whether a process input list is used for the 
corresponding order type.

If this isn't the case, the option process input list required can be deselected under the 
adjustment order input.

If a process input list is used, there will be a basic error in the input configuration or material 
and storage location administration.

Order system
2.2 Functions

Operator control and monitoring of batches
18 Function Manual, 11/2012, A5E00239386-09



Error 3: Process input list user function delivers FALSE
refer to user interface documentation (not part of the system)

Error 4: Writing of batch status into bali.dbf  failed
The writing of the file bali.dbf  can't be performed without errors. The reason can be a full hard 
disk. If the file is located on a network drive, a missing network connection can be the reason.

Error 5: Loading of batch in the CAS of start batch failed
The reason is usually a communication problem with the PCU.

Error 6: no CAS copy for the batch
An attempt was made to start a batch which is using a start unit without having an entry in the 
CAS image. This can only happen when the number of CAS entries is lower than the number 
of sequencers.

Error 7: no unit sequence for the batch
Incomplete or incorrect recipe engineering is present on this machine.

Error 8: Invalid batch values on enabling
The key of the batches is not valid.
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2.2.8.2 Status transition diagram
 

2.2.9 Order parameters
● For every order type up to 220  parameters can be assigned.

● All batches of an order type have the same order parameter definition.

● The parameters can be used in operations of the recipe procedure

Parameter category
● DFMs (digital function modules) DFMs can be taken from all PCUs. Input is the same (upper/

lower limit, dimension, dec. point) as defined for DFMs in the file 'sw.ini'

● Free order parameters. It is a 16 bit integer whose value is not checked as in the case of 
a DFM.
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Parameter type
● 'Standard' The input and signaling occurs the same (upper limit, lower limit, decimal point, 

dimension) as defined for the DFM in the file sw.ini.

● Sum for single batches like 'standard'. For the input of an order, the input refers to the 
amount of batches, i.e. for the batch generation the value is divided into individual batches 
(see transfer of the batch parameter).

Acceptance of batch parameters
● By creating batches, all order parameters, with the exception of sum parameters, are copied 

to the batches.

● The sum parameters refer to the number of batches and are calculated for the individual 
batches as follows: parameter (batch) = parameter(order) / size(order) * size(batch)

● A sum parameter must be defined during configuration under the application 'order system', 
'configuration', 'order type', 'order parameter'.

Preset order parameters
● The parameters can be preset with values of the recipe process parameter.

2.2.10 Order and batch number allocation
 

The following types are possible:

● Beginning with 1 by order

● Continuously per year and order type

● Order number as a calendar week

In case of an active connection to a PMS, the PMS allocates the order numbers for the order 
types that are used by the PMS.

The user cannot influence the order numbers.

In the case of an operation without PMS the number of the order is suggested by the system.  
The order numbers are assigned continuously.

The user has the possibility to overwrite this preset. An inspection occurs in this case to 
ascertain whether the input is permissible with regard to the explicitness of the order and batch 
numbers.  The input of an order number is only allowed if it has been enabled under 'order 
type', 'configuration', 'order type', 'order input', 'allowed inputs' for this order type.

2.2.10.1 Order and batch number area
The following rules apply for the allocation of the order and batch numbers:

● The next free number is always searched from 1 in ascending order.

● The maximum order and batch number is 32767.
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2.2.10.2 Batch and order numbers > 32767
The current version of the Braumat/SISTAR system supports the assignment of order and 
batch numbers above 32767. To ensure downward compatibility, this function must be enabled 
with the entry "ExtendedNumbers=1" in the "Balidata" section of "windcs\sys\bali.ini". 
"ExtendedNumbers=0" restores the default, and prevents the assignment of order/batch 
numbers higher than 32767.

2.2.10.3 Beginning with 1 by order
● The order numbers are allocated consecutively per year and order type. The batch numbers 

start with 1 for each order by preset. Any further batches are numbered consecutively.

● The first batch number can be changed by the user in any way (change option must be 
enabled in the configuration of the order type).

● The explicitness is checked with input of the order number by the user and the next valid 
number is suggested in case of error.

2.2.10.4 Continuously per year and order type
● The batch numbers are allocated per year and order type continuously. The first batch 

receives the batch number of the last batch of the previous order + 1. Any further batches 
are numbered continuously.

● The order number is identical to the first batch number as standard and stored in a file in 
order to avoid conflicts by changing the allocation mode.

● The order number can be changed in any way as it is always explicit by the batch number.

● Upon input of the batch number by the user the explicitness is checked and the next valid 
number is suggested in case of error.

The method for allocating the batch number is selected under the application 'order system'-
>'configuration'->'order type'->'batch generation'.

Any intervention in the automatic allocation of the batch number means that a consecutive 
numbering of the batches can't be guaranteed per order. 

The uniqueness of the batch numbers is always guaranteed.

2.2.10.5 Order number as a calendar week
Two subvariants are possible:

● Batch number running per calendar week

● Batch number running per calendar year

2.2.10.6 Order number as value plus calendar week
It is possible to extend the calendar week by values of the recipe category and the recipe 
number.
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The order number is calculated by the formula:
cw = cw + (RecCat + RecCatOffset)*RecCatFactor + (Recipe + RecipeOffset)*RecipeFactor

The offset and factor must be set with an ASCII Editor directly in the otypes.ini.

File: windcs\bali\otypes.ini
Key: [ordertypex] x is the order type number
Entry:: RecipeFactor=0
Entry: RecipeOffset=0
Entry: RTypFactor=0
Entry: RTypOffset=0

 

2.2.10.7 Reaching the maximum order and batch number
If the maximum order or batch number is reached (=32767), new batches can only be entered 
if the user deletes the corresponding number file! 

It is assumed that it also backs up the corresponding batch data under FRPROT , as these 
ones are overwritten with the new batches!

The number files for the order and batch numbers are stored in 'windcs\bali\used_nr
\onr_xx.yyy', the number files for the batch numbers are stored in 'windcs\bali\used_nr
\bnr_xx.yyy'. For this 

● xx  is the year and

● yyy  is the order type number.

Files that are marked with '~' are called backup files.

For the mode 'calendar week' the file hist_jj.dbf needs to be deleted after the previous backup.

2.2.10.8 Enabling numbers when deleting batches

Batch number, 'Start always with 1'
As these numbers aren't stored anywhere, they cannot be said to be released.  However, the 
highest available batch number is determined by attaching batches to a current order and the 
next one is simply used for the new batch.      If the batch with the highest available number 
is deleted, this number is reused for a new batch of this order. However, if a batch is deleted 
in between, its number isn't reused.

Batch Number, Consecutive Numbering
The number of one deleted batch is always released and reused.
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Order number
As a general rule, the number is released only when no batch has been run from the order, 
i.e. the 'number of batches' is the same as the rest number of batches, and if the complete 
order is deleted.

Order number as a calendar week 
The exact deleted combination of order and batch number is enabled and can be used again.

2.2.11 Batch input
● A total amount can be set. This one is then automatically distributed to individual batches.

● A number of batches can be set.

● A total amount and a number of batches can be set. The amount is allocated to the required 
number of batches.

2.2.12 Batch generation
There are two methods of generating batches. 

● The allocated amount of the order is distributed equally to the number of batches.

● Batches with the maximum size are set up in order to reach the allocated amount. The 
remaining quantity is set up as a remaining batch.

Determine batch count → Order size in batches
If the order size is indicated in batches, the number of batches is determined.

The nominal batch size is taken as a batch size, except for if

● the nominal size is smaller than the minimum batch size => minimum batch size is used

● the nominal size is larger than the maximum batch size => maximum batch size is used

Determine batch count → Order size as amount
If an order size is allocated as amount, the following can be selected from two methods for 
determining the batch number and size:

● All batches have the same size.  The number of required batches is calculated by the 
maximum batch size (rounded up to a whole number).  Note: Nominal batch size doesn't 
need to be between the minimum and maximum batch sizes. If the batch size is lower than 
the minimum, the user is informed and must make a decision.

● n batches with the maximum possible batch size and one remaining batch.  
Note: If the remaining batch size is lower than the minimum, the user is informed and must 
make a decision.
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The selection of the method for determining the batch number is executed under the application 
'order system'->'configuration'->'order type'->'batch generation'.

2.2.13 Batch sequence
The batch is started as soon as the start conditions have been met for the batch. Once the 
batch has started, the recipe for this batch is requested by the PCU. The recipe load function 
in the IOS determines which recipe procedure is required based on the request.

The batch-dependent setpoints are scaled in this recipe procedure and selected setpoints are 
replaced by batch parameters or by values from the process parameters. This batch-
dependent recipe procedure (name: control recipe) is loaded to the PCU and is executed there. 
If there are 'dose equipment operations' in the recipe procedure, the data from the process 
input list is incorporated into the control recipe.

The control recipes are created:
● from data from the recipe procedure (held by IOS)

● from data from the basic recipe (held by IOS)

● from data from the batch order (entered via IOS Editor)

● and from data from the component list (not batch-related, created in IOS)
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"Starting a batch" process description:

Following the order entry with the Bali Editor IOS application, the batches are formed and 
incorporated into the batch list. The processing is performed in the sequence of the entries 
(and according to start mode). 

Each recipe unit procedure is requested by the PCU before processing starts. The IOS 
converts the request in a batch-related control recipe. Order parameters, process parameters 
and data of the process input list flow into the control recipe. 

2.2.14 IOS - SQL server database coupling
The "Free Protocols" acquired during the batch process can be transmitted automatically to 
an MS SQL server database in the higher-level DB host system (via the "BRAUMAT SQL 
server coupling" optional package). 

The unique key for identification within PCU and IOS is year, recipe category, order number 
(16 bits) and batch number (16 bits).

The batch parameters can therefore include a string which is the batch name. This name has 
no meaning for the PCU.
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2.3 Configuration

2.3.1 Configuration
The order system is configured in 3 steps.

● Step 1 
Configuration of the connections and communication paths

● Step 2 
 See also: Start and server switchover

● Step 3 
Configuration of the order type. The basis for the order types is a current recipe 
configuration.  See also:   Recipe system

2.3.2 Connection to the server
For the start of the application 'order system', one connection to the recipe server is used. If 
no connection can be established, the following message appears:

This message always appears if no recipe server is active in the system.

First of all only the respective appropriation of the order/recipe system can be considered.

In order to use the order/recipe system, there are still some very system-specific configurations 
necessary, which can't be known during the installation phase of their system IOSs.

The following points should be considered during installation of the order/recipe system:

● The order/recipe system requires at least one, and with a redundant plant concept two, so-
called recipe servers. Recipe servers are IOSs that couple directly to the PCUs with a H1 
- bus connection.

 See also:  Installation & configuration  Recipe server

● The file 'area.ini' in the folder windcs\sys must be configured correctly, in accordance with 
the plant concept.
The necessary standard inputs in the files pcu_serv.ini as well as sys.ini are included with 
delivery. The inputs must be enabled and parameterized.

 See also:  Installation & configuration AREA.INI
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● In the PCU server of the IOS that should become the active recipe server (with a redundant 
system design in the PCU servers of the two IOSs which are enabled as recipe servers) 
the coupling option 'recipe server' must be activated.

 See also:  Installation & configuration PCU Server
 See also:  Installation & configuration

 Interprocess communication between the IOSs

● Then the IOS that should become the active recipe server in the PCU server is switched 
on under the program 'Activate recipe servers' or with the help of the corresponding button 
in the toolbar. 
The recipe server only boots if it receives acknowledgment of all PCUs that were 
parameterized in the file area.ini. If one of the parameterized PCUs does not report itself, 
it remains in the standby state.
This restriction can be switched off.

 See also:  Installation & configuration
  Startup recipe server

 

  Note

The order system of the client can only connect to one ‘Area Server pair’.
 

2.3.3 File Synchronization
The restart of an IOS as recipe server or a recipe server switchover automatically activates 
the 'Synchronization' application (synchro.exe) in the windcs\sys folder.

This application ensures that the newest data is available on the IOSs. It compares files on 
the IOSs and copies the newest files.

In the event of a recipe server switchover the synchronization is set in the recipe.ini file in the 
'\windcs\sys' directory:

● [StandByControl]
● StartFileSync=1
If StartFileSync = 1, the file synchronization is automatically activated by the redundancy 
switchover

● AbortWaitForSync=300

If no automatic file synchronization is selected ('StartFileSync=0=0'), it will wait for a maximum 
of 300 seconds, then the start as recipe server is aborted. 

2.3.4 Monitoring the recipe server
The monitoring of the recipe server can be configured in the file ‘recipe.ini’ in the 'windcs\sys' 
folder.

If the monitoring process is parameterized, at the parameterized time intervals, telegrams are 
triggered in all the PCUs participating in the recipe control process. 

These telegrams are of type 16 and are received by both the active recipe server and the 
standby recipe server.

Order system
2.3 Configuration

Operator control and monitoring of batches
28 Function Manual, 11/2012, A5E00239386-09



If a recipe server failure is detected, the message 'Recipe Server Failure' is output in all IOSs 
of the plant. 

Settings in the recipe.ini file
[ServerSupervising]

● Enable=1 
If Enable =1 is set, the monitoring of the recipe server is enabled. 
If Enable = 0 is set, the recipe server is not monitored. In this case, the message 'Recipe 
Server Failure' is therefore not generated. The automatic recipe server switchover can only 
run if the monitoring process has been enabled.

● CycleTime=30 
If CycleTime = 30, a message is triggered in all the PCUs participating in the recipe control 
process every 30 seconds.

● ReactionCycle=24
For ReactionCyle = 24, a message "Recipe server failed" is triggered after 24 messages 
have failed.  This parameterizes a reaction time of CycleTime x ReactionCycle = 24 x of 
30 Sec.

● RepeatTime=300
After RepeatTime=300, the message "Recipe server failed" is repeated

● WaitTime=240
After booting the PCU server, only after the time WaitTime=240 seconds is the monitoring 
of the PCU started.

● AutomaticServerActivation=0
In the event of a server failure or if the system is powered up without a clear server 
configuration in the assigned PCUs, user intervention is required.

● AutomaticServerActivation=1
In the event of a server failure, the system switches over to the spare recipe server 
automatically. For the function of this switchover, the monitoring of the recipe server 
[ServerSupervising] Enable=1 must be switched on. 

 

  Note
Power-up when there is no clear configuration in the PCUs

If no clear recipe server configuration can be detected in the assigned PCUs during power-
up (e.g. when AS is reloaded on a PCU), the 1st server in the AREA automatically powers 
up as the recipe server.

 

● Automatic server switchover is enabled by default (in the delivery state) 
(AutomaticServerActivation=1).
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2.3.5 Batch start cycle time processing

Criteria for the batch start
The CAS states of all start units of the enabled batches are checked cyclically. In addition to 
the cyclical search, a search is triggered with a status change to 'enabled', with the enabling 
of a CAS data record and with the creation of a new batch.

The cycle can be adjusted in the file bali.ini in the folder 'windcs\sys' under

● [balidata] 
SearchTime=80

. 

The value corresponds to the number of the PCU server timer calls (=200ms) in this case.

● This means: 80 corresponds to 80* 200 ms = 16 seconds.

A search is performed for batches which are to be started as soon as the CAS of the start unit 
of at least one enabling batch is free.

The batch list is searched from the top to the bottom.

The first batch with start mode 'as soon as possible' is started.

From the batches with mode 'after time' or 'after time/auto' the one with the shortest start time 
starts, regardless of its position in the batch list.

2.3.6 Order types

2.3.6.1 Order types
Order types must be defined before entering orders, whereby each order type is assigned to 
one recipe category. There is a 1:1 relation between order type and recipe category. The order 
type number is identical to the number of the recipe category.

The new order/recipe system isn't preconfigured, i.e, no order types are preset.

Configuration of the order types only makes sense if recipe categories, master recipes, recipe 
procedures, process parameters, process input lists, etc. were created.

 See also:  Recipe system  3.1 Creating a simple recipe.
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2.3.6.2 Configuration dialog selection

If the menu item 'configuration' isn't available, the current view with the menu item 'file' > 'close' 
must be closed.

2.3.6.3 Dialog 'Define order types'

To select the dialog box:
● Click "Configuration" -> "Order types"

Name
Here the name of the order type can be allocated (length of a maximum of 16 characters).
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A dimension name can be allocated (length of a maximum of 16 characters). The dimension 
is indicated during the order input.

Actual value 'batch size'
Here one parameter from the free protocols can be selected, which can be indicated as the 
actual value for the batch size in the batch list. For the function, a configuration of free protocols 
is necessary.

 See also:  Logging  Freely definable logs

Assignment
In the list, a recipe category can be selected to which the order type is assigned. If a selection 
is made in the list of existing order types, the currently assigned recipe category is displayed.

List 'name / dimension / ...
The order types which have already been configured are displayed in the list. The following 
information: Name, dimension, recipe category number and actual value of the batch size with 
diagonal stroke is displayed separately. For the selection of an order type, the input fields with 
the configured data are set.

If an order type is supposed to be edited, it must be selected in this list box. Then, a new 
definition can be selected. With the key '=', the changes are accepted.

Order input
With this button, you reach the dialog 'define order input'.

Batch generation
With this button, you reach the dialog 'define batch generation'.

Start mode
With this button, you reach the dialog 'define start mode'.

Order parameters
With this button, you reach the dialog 'define order parameter'.

Button '>>'
A new order type is included in the list. In this way, the name is loaded in the field 'name' and 
the selected recipe category is accepted and checked.
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Button '<<'
In this way, the order type which has just been selected is deleted.

Button '='
In this way, the definition of the selected order type with the current inputs is overwritten.

Button 'OK'
File definition and dialog end.

Button 'Abort'
Do not save file definition and dialog end.

2.3.6.4 Create new order type
Procedure when creating a new order type:

● In the 'recipe category' window, one recipe category is selected (click the requested recipe 
category).

● After the selection the desired name for the order type is entered in the window 'name'.

● With the key '>>', the recipe category is accepted in the list and is visible in the window 
"Name\Dimension\Recipe category\Process value".
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2.3.6.5 Dialog define batch generation

To call the dialog box
● Select "Edit"

● Select "Order types"

● Click "Starting mode"

Preset 'Batch state'
This selection determines with which status the batches are created after creation. It is possible 
to select between 'disabled', 'enabled' or 'ready'.   See also:  Batch states

Preset 'necessary to process input list'
Here is determined whether the batches of the order type use a process input list. The 
deselection of the function has advantages in terms of performance.

 

 Note

This item is only displayed if the license for the weigher program is registered in prod32.dll .
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Allowed inputs
This selection determines which input possibilities are enabled by creating batches.

● 'Order number editable'
The order number can be changed. A test to ascertain explicitness is executed.

● 'Order number editable'
The 1st batch number of an order can be changed. A test to ascertain explicitness is 
executed.

● 'Path input'
Path can be selected. If this option is deselected, the reference line of the assigned recipe 
is always decisive.

● 'Batch number'
Input possibility for the number of batches per order.

● 'Order size'
Input possibility for the size of each order.
If neither 'batch number' nor 'order size' is selected, 1 is always accepted as a number of 
batches per order.

● 'Batch year'
The year of the batch can be changed manually. The default setting is the current calendar 
year.

Button 'OK'
The changes are accepted temporarily. A final acceptance only occurs when the OK button of 
the dialog 'define order types' is pressed.

Button 'Abort'
The changes are not accepted.
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2.3.6.6 Dialog 'Defining batch building'

To call the dialog box
● Click "Configuration" -> "Order types"

● Click "Batch building"

Batch size
Here a selection can be made between the two types of batch building.

Reference batch size: Recipe procedure
The nominal batch size of the recipe procedure is used as default batch size. The limits to the 
recipe procedure are used.

Reference batch size: Master recipe
The batch sizes for the batch input are calculated as follows:

Default value: = nom. MR
minimum value: = min. RP / nom. RP * nom. MR
maximum value: = min. RP / nom. RP * nom. MR

(RP = recipe procedure; MR = master recipe)
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Batch numbers
Here, a selection can be made between the types of batch number allocation.

Order numbers
In the fields, the limiting values of the order numbers are indicated.

Button 'OK'
The changes are accepted temporarily. A final acceptance only occurs when the OK button of 
the dialog 'define order types' is pressed.

Button 'Abort'
The changes are not accepted.

2.3.6.7 Dialog 'Define start mode’

To call the dialog box
● Click "Configuration" -> "Order types"

● Click "Starting mode"

possible start modes
Here the possible start modes are defined, which are possible with the batch input

Button 'OK'
The changes are accepted temporarily. A final acceptance only occurs when the OK button in 
the dialog 'define order types' is pressed.
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Button 'Abort'
The changes are not accepted.

2.3.6.8 Dialog 'Define order parameter'

To call the dialog box
● Click "Configuration" -> "Order types"

● Click "BALIEDIT"

If the batch list is not completely empty a message appears stating that the order parameters 
cannot be changed.

Dialog
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Parameter
● PCU

The PCU is selected from which the parameter originates. The selection is not relevant for 
free parameters.

● EPAR Group
The group is selected from which the parameter originates. The selection is not relevant 
for free parameters.

● Equipment setpoint
Depending on the group, the EPARs of the groups 0, 1, 2 or 3 are displayed here. One 
EPAR is selected from this list. The selection is not relevant for free parameters.

Type
● normal

With the selection 'normal', the parameter is used for input and output as was determined 
in the setpoint definition.

● Route control
With the selection 'route control', the component is converted to route on input (corresponds 
to storage location). If this type is selected, one input field will appear next to it in which the 
silo group must be entered.

● Sum parameter
With the selection 'sum parameter', the input/output is the same as the selection of 'normal', 
with the difference that the parameter is distributed to the individual batches.
With the selection of 'normal', 'route control' and 'sum parameter' the EPARs are 
automatically selected.

● Free parameter
With the selection 'free parameter', an order parameter is defined that is not an EPAR. For 
this parameter, only one name can be allocated.

Actual value
One actual value can be assigned to each parameter. Actual values are columns from the 
dates of the free protocols. With this combo box, the column is selected in the dBase file.  With 
the selection 'no', no process value can be assigned.

For the function, a configuration of free protocols is necessary.

 See also:  Logging  Freely definable logs

List 'Parameter/PCU xxx'
In this list box, all order parameters and their definitions are entered.

Key '>>'
With this key, an order parameter of the list is added.
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Key '<<'
With this key, an order parameter is deleted from the list.

Key '='
With this key, the definition of the selected parameter (in list box 'parameter / ... ') is overwritten.

Button 'OK'
The changes are accepted temporarily. A final acceptance only occurs when the OK button of 
the dialog 'define order types' is pressed.

Button 'Abort'
The changes are not accepted.

2.3.7 Reconfiguration of order parameters

Requirements
The reconfiguration can occur only under specific conditions.

● Batches may not be available in the batch list. This test is executed by the application.

● All current batch archives must be paged out and deleted.

Note!
If there is a reconfiguration without saving the 'old' archives, no further batches can be created.

Note!
Current order parameters are assigned to their corresponding formal parameters (the 
placeholders in the recipe procedure in which these parameters are inserted by substitution), 
based on the line number of the order parameter in the order parameter definition list of this 
dialog box. When the arrangement of parameters in the list of this dialog is changed, the 
assignments in the recipe procedures are not automatically updated when order parameters 
are substituted in the recipe procedures. You must definitely take this point into account when 
you modify the parameter list. You can always append new parameters to the list, without 
having to adapt existing recipe procedures. All other modifications, for example deleting 
parameters or changing their position in the list, may cause an undefined behavior of the recipe 
procedures!
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2.3.8 Preset order parameters

Predefining order parameters
The order parameters in the "New order" dialog can be predefined in file '...\windcs\bali
\oparadef.ini'.

In this file, there is an area for every order type

[OrderType#] # stands for order type
Under this area, the values are listed for every order parameter. 

Parameter#= # stands for the number of the order parameter (starting 
with 1)

Fixed value
A fixed value is written directly behind the sign '='. Numbers with decimal places must be 
displayed with any points.

Examples:
Paramater1=5
Parameter2=6.67

Value from process parameter of the recipe of the batch
The order parameter can be preset with a value from the process parameters of the recipe. In 
this case, the number of the parameter (Index of the list beginning at 1) must be indicated with 
a leading '%' sign. 

Example:
Parameter1=%5
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2.3.9 Allocating/releasing order/batch numbers

Select the dialog in "BaliEdit":
● Click File/Close

● Click Engineering/Order numbers/Batch numbers

This dialog allows you to reconstruct order/batch numbers from the batch history in the system 
allocation list or to allocate/release number ranges.

● First, you have to select the "Year" and order type
The "Occupied order numbers/batch numbers" list fields show the current system allocation 
lists for the selection you have made.

● "Restore order numbers"/"Restore batch numbers" buttons
The batch history in the ‚…\windcs\Bali\hist_yy.dbf’ files is read and the order/batch 
numbers for the year and order category are entered into the system lists under ‚…\windcs
\Bali\Used_Nr’ .

● "Edit order numbers/Edit batch numbers" fields
Here, you can pre-assign or release the relevant number ranges.

– Enter "from"/"to" and press "Occupy" button → The number range is pre-assigned or 
reserved

– Enter "from"/"to" and press "Release" button → The number range is released or deleted
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 CAUTION

Data loss as a result of incorrect use

Once the order/batch numbers have been released, they are reused for any new orders or 
batches that are created. As a result, any batch reports that are left over get overwritten.

In addition to causing data loss, the incorrect use of this function can also result in incorrect 
assignments between steps and batches in reports/MIS/reporting.

Access to this dialog is protected by means of a dedicated program level: ‚BALI_PROJ’.
 

2.4 Start and server switchover

2.4.1 Activating the order/recipe system
The coupling is enabled in the PCU server of the IOS that needs to be activated as 'recipe 
server’ under the function 'coupling'.

If the coupling is not enabled as 'recipe server' the recipe server can't be activated. The function 
under 'Program' 'Activate Recipe Server' or the corresponding button in the toolbar  is viewed 
in gray color and can't be operated.

This also applies if the IOS hasn't been enabled in the ‘area.ini’ file or if the IOS has already 
been activated as recipe server.

On the IOS which should be recipe server, the recipe server is switched on in the PCU server 
under 'Activate Recipe Server'.  The same function can be activated by pressing the button 

 in the toolbar.
 

 Note

The recipe server only boots if it receives acknowledgment of all PCUs that were 
parameterized in the file area.ini. 

If one of the parameterized PCUs fails to respond, it remains in a standby state.

This behavior can be changed.

 See also:  Installation & Configuration  Startup recipe server

If a PCU server which was previously an active recipe server is restarted, this IOS will 
automatically become a recipe server again.

By starting up the server, a file synchronization is executed with the backup server.
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2.4.2 Procedure in the case of recipe server failure
First it must be stated if the recipe server has really failed. If this is the case, an attempt should 
be made to boot this IOS again.

If you are unsuccessful, the order and recipe system must be activated on the reserve recipe 
server.

The failure of the recipe server can also be signaled if the recipe server has its full functionality. 

This message may be caused by these events:

● The connection to one or more PCUs has been aborted

● One or more PCUs are in STOP state

● The IOS is heavily overloaded; the monitoring messages could not be processed in the 
parameterized time.

The default is no automatic activation of a standby recipe server (delivery state). This is also 
the safe operation type, as a switchover always indicates an interruption to the production 
sequence.

2.4.3 Recipe server switchover
As any recipe server switchover represents a major intervention in the recipe control, this 
function should only be implemented if absolutely necessary (e.g.: server failure or server 
upgrading during continued production!).

If there is no server failure, it has to be ensured that the plant is idle during the switchover.  

This means that either no batch is running or the running batch is in safe condition from the 
recipe view.

Sequence of the Server start
● Set PCU server on the backup recipe server to coupling 'recipe server' if it hasn't yet been 

set.

● Press the Apply button  on the PCU server; a dialog appears indicating whether this IOS 
should become the recipe server.
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● Confirm the dialog box with OK

● If the window of the recipe control is opened, the following steps are performed:

– FIFO Check:
Read out the FIFO configuration of the PCUs entered in area.ini

– FIFO Set:
Reconfiguration of the FIFOs for the new recipe server IOS

– KillTeleWait:
Wait for killer messages →  active recipe server is switched to 'STANDBY'!

– FileSync:
File synchronization is executed by the recipe server. Do not abort!

– TA/CAS Setup:
CAS and sequencer data are read

– BALIDAT Setup:
BaliData.dll  is enabled

– RECCTRL Setup:
RecCtrl.dll is enabled

The reserve recipe server is now the active recipe server.
 

 Note

If SISTAR applications are open which require this coupling (order system, plant overview, 
recipes, etc.) these are held with a corresponding message box and can only be used after 
a application new start!

 

Switchover of the Clients
This can occur automatically under the following circumstances. In the sys.ini of the Client IOS 
the address of the standby recipe server must be entered in addition to the TCP/IP address 
of the recipe server as the secondary TCP/IP address:

[IPAddr]  
PCU252=27.1.99.1; 27.1.99.2 TCP/IP Address of Recipe Server and the
PCU253=27.1.99.1; 27.1.99.2 Standby Recipe Server
PCU254=27.1.99.1; 27.1.99.2  
PCU255=27.1.99.1; 27.1.99.2  
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Possible errors on switchover of the recipe server:
● Recipe server is in the 'standby' status and the activate button is not active:

– Cause:
The IOS is not installed for the operation as recipe servers → area.ini checks

● With the start of the order system the 'data transfer error' message appears:

– Bst-Read-Error (-4)'

– Cause:
The order system cannot access the BaliData.dll.

Relief:
● When starting the recipe server consider:

PCU-server coupling must stand on 'recipe server'. Test whether balidata.dll is correctly 
entered in pcu_serv.ini. The balidata.dll must be enabled.

● When starting the backup recipe server consider:
PCU-server coupling must stand on 'recipe server'. The TCP/IP address of the recipe server 
must be entered correctly in the sys.ini . The Client.dll must be entered in pcu_serv.ini 
correctly. On the recipe server the BaliData.dll must run and be enabled.

2.5 Menu dialogs

2.5.1 Dialog 'New Order'

2.5.1.1 Dialog 'New Order'
To select the dialog box:

● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "Close"

● Select "Edit"

● Select "New order"
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2.5.1.2 Dialog

With this dialog new orders with their parameters can be created. 

The input of batch number or order size can be disabled.

 See also:  Batch input

Numbers
Here the order and the batch number of the 1st batch of the new order are entered. The 
numbers are suggested by the system. The number can be changed if this is enabled. If the 
order consists of more than one batch, the order numbers will be allocated by the system, 
using the defined algorithm.

Order
The order type, the recipe and the line for the new order are queried. When opening, type, 
recipe and line are preset automatically.

Combo box 'line'
With this it can be determined on which line the order is supposed to run. It can be configured 
whether a line input is possible. By opening the dialog, the line is preset with the reference line 
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of the current recipe. With the line selection, the start unit is determined implicitly (via recipe 
header and assignment table). The permissible lines are stated per recipe.

Start
The following start modes (like CAS modes) can be selected: 

● 'as soon as possible'

● 'after time'

● 'after event' and

● 'after time/auto'

● For each order type the selection of the mode can be limited.
 See also:  Batch input

The indication of 'date' and 'time' refers to the mode 'after time'. The cycle determines the time 
difference between the individual batch starts.

With the selection of the recipe, the cycle and the start time is preset with the current values 
for the selected recipe. However, these values can be overwritten.

Order size
Here, either only the number of batches for an order or the size of the order or both are entered. 
When leaving this field the batches are generated according to the method configured for this 
order type.

 See also:  Batch input

 See also:  Batch generation

Key '>>'
Has no importance for this version.

Key 'Parameter'
Call of the dialog 'order parameter'. This call is absolutely necessary if parameters were defined 
for this order type. Only then are the keys 'OK' and 'further order' enabled.

Key 'Additional order'
Acceptance of the current order and input of a further order.

Key 'OK'
Accept new order data and dialog end. After that, it will be automatically branched out to the 
batch list (view: all batches of this order).
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Key 'Abort'
Do not accept new order data and dialog end.

2.5.1.3 Error report at order input

Message Box 'Invalid Recipe Header'
The dialog starts with a presetting that indicates a recipe for which no valid recipe header is 
configured. A selection of different order types and recipes with valid data is possible.

Message Box: 'Invalid Input!' 
If a Message Box: 'Invalid recipe header!'  

● is output by entering new orders the following values are not plausible 
i.e. in this case <= 0:

– nominal batch size

– minimum batch size

– maximum batch size

In this case no new orders can be entered. The values have to be > 0.

2.5.1.4 Creating orders for recipe procedures with stream control
The BRAUMAT/SISTAR CLASSIC V6.0 order system supports the integration of recipe 
procedures with stream control. When you program a new order, you can select the batch 
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production line from the "Path" combo box on the bottom left. You can click ">>" to expand the 
"New order" dialog box to open the bitmap diagram for the currently selected path.

Figure 2-1 "New order" dialog box, showing the bitmap diagram of the path set in the combo box on the bottom left.

You can always modify the stream while the batch process is running. However, the system 
imposes a physically required restriction on your hot-change options: 

● i.e. you can select only the streams which contain at the time of change all the units to be 
used.

To reconfigure the stream while the batch process is running, double-click the path name in 
the order list (default line name "LinieName", reconfiguration possible by means of the 
"Options->Layout" command is possible) to open the "Change stream" dialog box.

Figure 2-2 Dialog box for changing the stream of an active batch production in the ‘Order list’ program. 
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This dialog box is opened by double-clicking the name in the LinieName column.

2.5.2 Dialog 'order parameter'
To select the dialog box:

● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "Close"

● Select "Edit"

● Select "New order"

● Confirm with the order parameter button

The window is used for changing order parameters. For the selected line a new value can be 
entered in the field 'value'.

The dialog can be opened for an existing batch. 

In the header, it is indicated for which batch the parameters are displayed and changed.

Key 'Next'
The system jumps to the next parameter and the input focus is set in the field 'value'.

Key 'OK'
The parameters are accepted and the window 'order parameter' is closed.
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Key 'Abort'
The window 'order parameter' is closed.

Value with text variables
This field is used for the value input. With text variables, the value can be selected from a list. 
Then, the field looks like the dialog above. With the selection 'delete', the value 0x8000000 is 
set.

Value with setpoints

The dimension specification, the minimum and the maximum limiting value are displayed 
above.

2.5.3 Dialog 'delete order'

To select the dialog box:
This dialog box is only available after you have preselected the order list.

● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Select "Open order list"

● Select "Edit"

● Click "Delete"
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All batches that haven't been started yet are deleted. Batches which have already been started 
cannot be deleted.

Order
The order type and the amount of remaining batches are displayed.

Delete
Deletes the batches.

Abort
Leaves the dialog without deleting.

2.5.4 Dialog 'Move order'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Select "Open order list"

● Select "Edit"

● Click "Move"

This window can be selected via the menu item. The easier operation is possible by clicking 
the line number and moving in the new line ("drag and drop").

With this window the production sequence can be changed.

Order
The order number that is supposed to be displaced is indicated.
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Move
The line positions are indicated from which the order is supposed to be displaced.

Key 'OK'
Displace and dialog end.

Key 'Abort'
Do not displace and dialog end.

2.5.5 Dialog 'Change order state'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Select "Open order list"

● Select "Edit"

● Click "Order status"

Current status
Signal of the current order state. In the header line of the dialog the order number is displayed.

New state
A new state can be selected from the list. 'disabled', 'ready', 'enabled', 'delete'. If no status is 
selected, this is the same as 'abort'
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Key 'OK'
New order status accepted and dialog end.

Key 'Abort'
Do not accept new order state and dialog end.

Selection 'Disabled'
All batches of this order which are ready, enabled or ready to start are disabled.

Selection 'Ready'
All batches of this order which are disabled or enabled are set to ready.

Selection 'Enabled'
All batches of this order which are disabled or ready are enabled.

Selection 'Delete'
All batches of this order which are ready, enabled, ready to start or disabled (no current ones) 
are deleted.

2.5.6 Dialog 'Increase number of batches'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "View batch list"
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● Select "Edit"

● Click "Number of batches"

The number of batches can be increased. If the number of batches is supposed to be reduced, 
the batches must be deleted via the change of batch state in the batch list.

Selection 'add to order'
The new batches are appended directly behind the last batch of the order in the order database.

Selection 'add to list'
The new batches are attached to the end of the customer sequence database.

2.5.7 Dialog 'Change Batch state'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "View batch list"

● Select "Edit"

● Click "Batch status"

In the header, the order and batch number are displayed for which the change is executed.
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Current status
Signal current status of the batch

New state
A new state can be selected from the list. If no selection is made, this is equivalent to pressing 
the key 'abort'.

Selection
It can be determined for which batches the change is supposed to be valid: 'only this batch': 
only for the current batch or 'all batches of the order': for all batches of the order in the current 
line that haven't been started yet.

Key 'OK'
Accept new batch state and dialog end.

Key 'Abort'
Do not accept new batch state and dialog end.
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2.5.8 Dialog 'Change batch size'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "View batch list"

● Select "Edit"

● Click "Batch size"

With this dialog the batch size can be determined. The nominal, minimum and maximum batch 
size is taken from the recipe procedure header. There are also different sizes possible. If the 
selected size isn't between the minimum and maximum size, an additional dialog appears in 
which this must be confirmed.

Key 'OK'
Accept new batch size and dialog end.

Key 'Abort'
Do not accept batch size and dialog end.

2.5.9 Dialog 'Move batch'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "View batch list"
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● Select "Edit"

● Click "Move batch"

This window can be selected via the menu item. The easier operation is possible by clicking 
the line number and moving in the new line ("drag and drop").

With this window the production sequence can be changed.

Batch
In the fields, the order number and batch number of the displacing batch are indicated.

Move
The line positions are displayed.

Key 'OK'
Displace and dialog end.

Key 'Abort'
Do not displace and dialog end.

2.5.10 Dialog 'Change start data'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "View batch list"
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● Select "Edit"

● Click "Change starting data" or "Change starting mode"

Start
● Mode

Here the start mode of the batch can be changed. In the selection, only the modes which 
are permitted in the order type configuration are offered.

● Date
Input field for the date in the format day.month.year The input is only possible in the start 
mode 'after time' and 'after time/auto'.

● Time
Input field for the time in the format hour:Minute:Second The input is possible only in the 
start mode 'after time' and 'after time/auto'

2.5.11 'Batch process input list' dialog box
 

 Note

This dialog box is only available if the weighing program license is registered in "prod32.dll", 
and you have set the "Process input list required" parameter when you created the order. 
You also need to configure the master data for the materials.

 See also:  Weighing and weighers
 

 

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "View batch list"
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● Select "Edit"

● Click "Process input list"

This dialog is only available if you have set "Process input required" in your configuration of 
the order type of the batch. 

You can modify the values in the following columns of the process input list, provided the 
current batch status is "locked":

● Volume
The material metering volume in this line

● Metering group
The material metering group in this line (metering sequence).

Notes:
● In contrast to this, the changeability can always be forced, i.e., regardless of the batch state, 

with the following switch in
..\windcs\sys\BALIEDIT.INI:[Settings]...CompListEditAlways=1
This corresponds to the old behavior (to V4.6)

● Metering processes with the selected metering group must be defined in the recipe 
procedure in order to ensure weighing of the material.

● After you have enabled stock management and tank selection, you can select a tank from 
the "Siloname" column by means of a text list selection dialog, and thus override the 
"automatic" or preset selection.
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If the material volume in this tank volume is too low, a corresponding message pops up, and 
the text of the corresponding process input line is marked in red color. You can only select a 
tank that contains the corresponding material.

You can always return to "automatic" mode.

2.5.12 Dialog 'Color of states'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "Open batch tracking"

● Select "Options"

● Click "Sequence status colors"

One can change the front and background color for every status. 

The colors can be changed for the 

● batch states (are the same as the order states)

● sequence states (recipe unit procedure status)

Example 'recipe unit procedure states'

Key 'Changing'
Open the Windows Standard dialog 'Define colors' from which the requested color can be 
selected for the front and background.
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2.6 Views

2.6.1 View 'order list'
 

In the order list all current or future orders can be displayed. You can update the displayed 
batches/orders manually by reselecting the current view in the menu or by using the button in 
the toolbar.

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Select "Open order list"

2.6.1.1 Dialog 'open order list'
With this dialog, a view of the order list is opened. Depending on the selected option, all or 
only partial amounts of the running and future orders are displayed.

The dialog can be opened via the menu item 'file' – 'open order list' or via the button  of 
the button bar.
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Order type
● All

All orders of different order types are displayed.

● Selection
Only 1 order type is selected for which the orders are displayed.

Orders
● All

All orders, i.e. current and future orders, are displayed.

● Running only:
Only orders where at least one batch runs are displayed.

● Selection:
Only batches of the order selected in the combo box are displayed.

Key 'OK'
The order list is opened according to the selected options.

Key 'Abort'
The selection is aborted and it is returned to the old view.

2.6.1.2 View
The column sequence (Layout) can be determined per order type. Individual columns can also 
be dropped completely. For the order list, several layouts can be determined.

● for the selection 'all order types'

● for every order type
For every order type, type-specific parameters can be accepted in the layout for every order.

 See also:  Layout adjustments
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Part of an order list view

2.6.1.3 Operation with the mouse
● Double-clicking on the status of an order opens the dialog 'change order status'

 See also:  Dialog 'Change order state' 

● A double-click on the size or the batch number opens the dialog 'Increase batch number'.
 See also:  Dialog 'Increase number of batches'

● A click on the line number and displace opens the dialog 'Move order' with the line number 
of the mouse click as 'of' indication and the line number of the mouse click as 'after' 
indication.

 See also:  Dialog 'Move batch' 

2.6.1.4 Menu bar

Program
● This menu area is filled according to the entries in 'Menuappl.ini'.

Form editor [Ctrl+F7]
● Call of the application 'Recipe editor' with the current master recipe

Unit overview [Ctrl+F8]
● Call the application 'sequence control' for the selected order.

File

Open order list [F2] Branch out to the dialog 'order list'
Open batch list [F3] Branch out to the dialog 'batch list'
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Open batch monitoring [F5] Branch out to the dialog 'batch monitoring'
Open batch monitoring history [F6] Branch out to the dialog 'History'
Batches for order [Shift+F3] For the current line the batch list is called.
Batch monitoring [Shift+F5] For the current line the batch monitoring is called.
Last view [F9] The currently selected view is closed and the view which has 

been selected before is opened.
Print... [F4] Branch out to the dialog 'print'
Close [Ctrl + F4] The current selection is completed and the engineering view 

appears.

Process

New order Branch out to the dialog 'New Order'
Delete order The batches of the order of the current line are deleted.
Move order An order is displaced to a different position.
Order state For the order of the current line the order state can be changed.
Batch number For the order of the current line the number of batches can be increased. If 

the number of batches is supposed to be reduced, this must be executed by 
changing the batch state.

Options

Button bar Switch button bar on/off
Status line Switch status line on/off
Function keys Switch function key marking on/off
Layout Create/change layout for the table.
Colors order state Define colors for the order state

2.6.1.5 Button bar

Close Application

Acknowledge ICM error

Acknowledge horn

Open order list 

Open batch list 

Open batch monitoring 

Open history  
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Print

Open batch list for current order

Open batch monitoring for current order

Back to the last view

2.6.1.6 Status line

1. Field: Current line / maximum number of lines
2. Field: Order number of the current line
3. Field: unused
4. Field: Additional notes
5. Field: unused
6. Field: Total number of data records in the batch database bali.dbf

2.6.2 View 'batch list'

2.6.2.1 View 'batch list'

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File" 

● Click "View batch list"

In the batch list all current or future batches can be displayed.

2.6.2.2 Dialog 'Open batch list'
With this dialog, a view of the batch list is opened. Depending on the selected options, all or 
only partial amounts of the current or future batches are displayed.

The dialog can be opened by selecting "File" > "Open batch list" or by pressing the  button 
on the toolbar.
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Order type
● all

All orders of different order types are permitted. The batches are displayed without any 
additional parameters, as these ones are order type-dependent.

● Selection
Only 1 order type is selected. The display is executed with additional batch parameters, as 
projected for this order type.

Orders
● all

All orders, i.e. current and future orders are selected.

● running only:
Selection of orders where at least one batch runs.

● Selection:
Only batches of the order selected in the combo box are selected.

Batches
● All

All batches of the selected order are displayed.

● In the mode 'ready-to-start'
Only the batches that have already been loaded into the PCU (CAS) for the next start of a 
unit are displayed.
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● In the mode 'running'
Only batches of the selected orders which have already been started in the PCU (PS) are 
displayed.

● Selection
The batch selected in the combo box is displayed.

Key 'OK'
The batch list is opened according to the selection.

Key 'Abort'
The selection is aborted and it is returned to the old view.

2.6.2.3 View
The column sequence (Layout) can be determined per order type. Individual columns can also 
be dropped completely. Several layouts can be determined for the batch list.

● For the selection 'all order types'
In this layout no order parameters can be included

● For every order type
Type-specific parameters can be included for every order type in the layout.

 See also:  Layout adjustments

Part of a 'batch list' view
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2.6.2.4 Operation with the mouse
● Double-clicking on the status of an order opens the dialog 'change order status'

 See also:  Dialog 'Change order state' 

● Double-clicking on the start time or the start mode opens the dialog 'change start dates'.
 See also:  Dialog 'Change start data' 

● A click on the line number and displace opens the dialog 'Move batch' with the line number 
of the mouse click as 'of' indication and the line number of the mouse click as 'after' 
indication.

 See also:  Dialog 'Move batch' 

2.6.2.5 Menu bar

Program
This menu area is filled according to the entries in "Menuappl.ini".

Control recipe [F7] 'Control recipe' Call of the application 'Recipe editor' with the current master 
recipe

Process input list [F8] Opens the process input list for the selected batch.
Formula Editor [Ctrl+F7] Call of the application 'Recipe editor' with the current master 

recipe
Unit overview [Ctrl+F8] Call of the application 'sequence control' for the selected 

batch.

File

Open order list [F2] Branch out to the dialog 'order list'
Open batch list [F3] Branch out to the dialog 'batch list'
Open batch monitoring [F5] Branch out to the dialog 'batch monitoring'
Open batch monitoring history [F6] Branch out to the dialog 'History'
Batches for order [Shift+F3] For the current line the batch list is called.
Batch monitoring [Shift+F5] For the current line the batch monitoring is called.
Last view [F9] The currently selected view is closed and the view which has 

been selected before is opened.
Print... [F4] Branch out to the dialog 'print'
Close The current selection is completed and the engineering view 

appears.

Process

New order Branch out to the dialog 'New Order'
Add batch For the order of the current line, a batch is added.
Move batch Branch out to the dialog 'Move batch'
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Batch state Branch out to the dialog 'Change batch states'
Batch size Branch out to the dialog 'batch size'
Change start time Change start time of the batch
Change start mode Change start mode of the batches

Options

Button bar Switch button bar on/off
Status line Switch status line on/off
Function keys Switch function key marking on/off
Parameter window Opening of the window 'batch parameter'
Layout Create/change layout for the table
Colors batch state Change the colors for the batch condition

2.6.2.6 Button bar

Close

Acknowledge ICM error

Acknowledge horn

Open order list 

Open batch list 

Open batch monitoring 

Open history  

Print

Open batch list for current order

Open batch monitoring for current order

Back to the last view

2.6.2.7 Status line

1. Field: Current line / maximum number of lines
2. Field: Order number of the current line
3. Field: Batch number of the current line
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4. Field: Additional notes
5. Field: unused
6. Field: Total number of data records in the batch database bali.dbf

2.6.3 View batch monitoring

2.6.3.1 View batch monitoring

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File" 

● Click "Open batch tracking"

All running or future batches can be displayed in the batch monitoring.

As the menus, symbols and dialogs of the batch monitoring correspond to those of the batch 
list, only the deviations are described here.

2.6.3.2 Dialog 'Open batch monitoring'
The open dialog is the same as used in batch list view.

 See also:  View 'batch list'

2.6.3.3 View
The column sequence (Layout) can be determined per order type. Individual columns can also 
be dropped completely. For the batch monitoring, several layouts can be determined.

● For the selection 'all order types'
In this layout no order parameters can be included

● For every order type
Type-specific parameters can be included for every order type in the layout. 

 See also:  Layout adjustments
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View

2.6.3.4 Operations with the mouse
 See also:  View 'batch list'

2.6.3.5 Menu bar
 See also:  View 'batch list'

In addition, under 'options' there is the menu item

Sequence status colors
This menu item calls the dialog 'color sequencer states'.

2.6.3.6 Button bar
 See also:  View 'batch list'

2.6.3.7 Status line
 See also:  View 'batch list'

2.6.4 History view

2.6.4.1 History view

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File" >Click "View history"
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In the history, all started, running, aborted and deleted batches can be displayed.

A batch appears in the history as soon as it has been started or deleted. The sequence of the 
batches is determined via the start/delete time whereby the batch with the most current time 
stands at the beginning of the list.

2.6.4.2 Dialog 'Open history'
With this dialog, a view of the history is opened. Depending on the selected options, either all 
or only partial amounts of the batches from the history are displayed. In general, the batches 
are always displayed pages by page due to the high amount. The amount of batches per page 
can be allocated in 'Options' 'adjustments' in the configuration view.

Year
The year determines the archive file from which the batches are displayed. There is a separate 
file for each year which is identified with hist_xx.dbf  (xx=year). i.e. the history can only be 
moved within one calendar year. 

This file is always completely read in. It contains all batches which were created per year (in 
the example calendar year 2000). The start time also contained in the file can differ!

Month, Day
These two indications determine the starting point in the history. The page is displayed which 
contains the first batch with the appropriate start/delete time. These indications do not result 
in any restrictions in the selection.

This page can also contain batches with other start times (pages are fixed and are always 
completely indicated). From there, one can then move again in the whole file
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Order type
● All

All orders of different order types are permitted.

● Selection
Only 1 order type is selected.

Orders
● All

All orders i.e. current and future orders are selected.

● Selection:
Only batches of the order selected in the combo box are selected.

Batches
● All

All batches of the selected orders are displayed.

● Selection
The batch selected in the combo box is displayed.

Key 'OK'
The history is opened according to the selection.

Key 'Abort'
The selection is aborted and it is returned to the old view.

2.6.4.3 View
The column sequence can be determined. Individual columns can also be dropped completely.

The definition of the layout and the color of the batch states are identical to the batch list.

Functions for processing, creating, displacing or deleting batches can't be executed here. For 
displaying the batch parameters, the parameter window is to be opened from the menu 
'options'.

2.6.4.4 Operations with the mouse
No operations with the mouse are possible in the list.
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2.6.4.5 Menu bar

Program
This menu area is filled according to the entries in 'Menuappl.ini'.

File

Open order list [F2] Branch out to the dialog 'order list'
Open batch list [F3] Branch out to the dialog 'batch list'
Open batch monitoring [F5] Branch out to the dialog 'batch monitoring'
Open batch monitoring history 
[F6] 

Branch out to the dialog 'History'

Last view [F9] The currently selected view is closed and the view which has been 
selected before is opened.

Print... [F4] Branch out to the dialog 'print'
Close The current selection is completed and the engineering view 

appears.

View

Page forward [F7] Page forward by one page (in the future)
Page down [F8] Page down by one page (in the past).
First page [Shift+F7] Jump to the first (most current) page of the history
Last page [Shift+F8] Jump to the last (oldest) page of the history

Options

Button bar Switch button bar on/off
Status line Switch status line on/off
Function keys Switch function key marking on/off
Parameter window Opening of the window 'batch parameter'
Layout Create/change layout for the table
Colors batch state Change the colors for the batch condition

2.6.4.6 Button bar

Close

Acknowledge ICM error
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Acknowledge horn

Open order list 

Open batch list 

Open batch monitoring 

Open history  

Print

Page forward

Page down 

Jump to the first page

Jump to the last page 

Back to the last view

2.6.4.7 Status line

1. Field: Current page/maximum number of pages
2. Field: Order number of the current line
3. Field: Batch number of the current line
4. Field: Additional notes
5. Field: unused
6. Field: Total number of data records in the selected history database hist_xx.dbf

2.7 Adjustments
 

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "Close"
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● Select "Options"

● Select "Settings"

With this dialog the basic settings for the editor and four views can be made.

General

'Filed Views' Number of views which are held in the page file.

Order list
Adjustments for the order list view. 

'Grid' Indicate table grids.
'Line numbers' Indicate column for line numbers.
'Fixed Columns' Number of fixed columns on the left table edge. These are not moved by 

the vertical scrolling.
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Batch list

'Grid', 'line number' and 'fixed columns' as for order list
'Parameter window' View parameter windows automatically by opening the view.

Batch monitoring

'Grid', 'line number', 'fixed columns' and 'parameter window' as with batch list
''Width'' Width in display units (Pixel) for the Seq columns.
'Seq.-short name' Use unit short names in the Seq columns.
'Seq.-heading' Heading for the Seq columns.
'Seq.-number' Indicate unit number in the Seq column heading in addition.

History

'Grid', 'line number', 'fixed columns' and 'parameter window' as with batch list
'Lines per page' Number of lines which are displayed per page in the history.

2.7.1 Layout adjustments

To select the dialog box:
● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Select "Open order list" or "Open batch list", or click "Open batch tracking"

● Select "Options"

● Select "Layout"

The layout adjustments can be adjusted for order, batch and batch tracking separately.

For every order type, specific layout adjustments can be executed.

For the view 'all order types', one layout adjustment can be executed.

The adjustments are changed for the view which has just been displayed. The view is displayed 
in the header line of the dialog.
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Available columns
In this list, all remaining columns that aren't used in the view are displayed.

Selected columns
In this list, all columns of the view are indicated in the sequence from left to right.

Parameter
In this list, the parameters of the order type are indicated. The list is empty in the layout dialog 
of the order list or batch list in which all types have been selected.

Key '<<'
With this key, the selected column is removed from the list.
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Key '>>' 
With this key columns are added in the view.

 

 Note

Parameters can't be displayed in the order list as they are batch-related!
 

In the batch list view with the display of all batches, no parameter can be indicated. 

Key 'up'
With this key, the selected column is moved upwards by one position.

Key 'down'
With this key, the selected column is moved downwards by one position.

Input field 'buffer size'
Input of the maximum character count for the selected column (8-32).

Input field 'Width in pixel'
Input of the column width in display units (pixel) (25-250).

Input field 'text alignment'
The text can be aligned in the left, right or middle of the column.

Input field 'Headline'
Input of the column header.

2.7.2 Batch/order and sequence status colors dialog box
To select the "Batch/order status colors" dialog box:

● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Select "Open order list" or "Open batch list", or click "Open batch tracking"

● Select "Options"

● Select "Order status colors"

To select the sequence status dialog box:
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● From the main menu, select "Process monitoring" -> "Batch list"

● Select "File"

● Click "Open batch tracking"

● Select "Options"

● Select "Batch/order status colors"

The foreground and background colors indicating the status can be set individually.

Key 'Changing'
Open the Windows Standard dialog 'Define colors' from which the requested color can be 
selected for the front and background.

2.7.3 Command line of BaliEdit.exe
The application baliedit.exe can be started by using parameter in the command line.

Call:
baliedit <View> <Order type> <Order number> <Order state> <Batch number> <Batch state>

 

<View>

Order The 'Order list' view is opened
Batch The 'Order list' view is opened
BaMon (Batch monitoring) The 'Order list' view is opened

If there aren't any further parameters, all batches are displayed in each case. 
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<Recipe type> default: 0
0 Selection of the data records is independent of the order type
Number Only data sets with this recipe type are selected

<Order number> default: 0
 Selection of the data sets is independent of order number
Number Only data sets with this order number are selected

<Order state> default: x
x The display of the data records occurs independent of the order state
S (Started) 

Only those data records are selected which have the order state 'started'

<Batch number> default: 0
0 Selection of the data sets is independent of batch number
Number Only the data records with this batch number are selected.

<Batch state> default: x
x The display of the data records occurs independent of the batch state
R (Ready) 

Only those data records are selected which have the batch state 'ready to 
start' 

S (Started) 
Only those data records are selected which have the batch state 'ready to 
start'

2.7.4 Password protection
All operations in the application 'BaliEdit' are protected by a password. You divide between 
various password levels.

● Change parameters

● Change, enable, disable status of a batch

● Abort batch

● Input, delete order

● Add and delete batch

● Configuration
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2.7.5 Example
Chapter 3 of the "Recipe system" manual contains a simple recipe sample. This recipe controls 
the draining of caustic cleaning solutions, and shall now be started by the order system.

In this example, the master recipe "Cleaning" is assigned to the recipe category "Cleaning 
processes" (ClP).

Starting the order system
● From the main menu, select "Process monitoring"

● Double-click "Batch list"

To set up the order type for the order system
● From the main menu, select "File"

● Click "Close"

● From the menu, select "Configuration"

● Select "Order types"

Order system
2.7 Adjustments

Operator control and monitoring of batches
84 Function Manual, 11/2012, A5E00239386-09



● Enter the name (ClP) and the dimension name (hl) in the dialog box. Apply the cleaning 
recipe category by double-clicking its name. For this example you can accept the batch 
building and order input defaults. Order parameters are not required, because the recipe 
does not contain any parameters.

● Click the button. In the dialog box, set the start mode "soon as possible" and "time 
controlled". A description of this setting is found in chapter "Start modes (Page 15)". You 
can now confirm all settings with OK.

Creating a new order
● Click "File" -> "Close"

● Click "Edit" -> "New order"

In this dialog box, you can increase the number of batches. Click OK to confirm your entries 
and to close the dialog box.

The order list should now contain an order.
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● Click "File" -> "Open order list"

The batch list should contain two batch orders, because this order consists of two batches.
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● Click "File" -> "Open batch list"

The order is locked and cannot yet be processed, which means you need to enable batch 
processing.
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● Click "File" -> "Open order list"

● Click "Edit" -> "Order status"

● In the dialog box, set "Released", and then close the dialog box with OK

The order status is briefly set to "enabled" and then changes to "Started".

In the plant overview, you can monitor the recipe sequence of both batches (see section 2). 
The "Batch tracking" feature also allows you to monitor the batch process.

After processing of both batches is completed, the order status changes to "Done".
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Batch tracking
● Click "File -> Open batch tracking"
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Plant Overview 3
3.1 Functionality

In the current version every unit can have 1 sequence. Therefore, the terms unit and sequence 
are used synonymously in the description. 

The application 'Sequence control' is used for the representation of the current state of the 
process cells. In addition, it is possible to select and to operate the individual units. With this, 
the user can intervene in the current process and influence the different processes. In the 
sense of S88, process cells are defined units of the entire system that can work partly 
independently.

Program start
From the main menu, register tab ‘Process monitoring > Sequence control’

3.2 Configuration

3.2.1 Configuration 
 

You can call the ‘Process cell’ command from the menu to select a PCELL or an overview of 
the sequencers.

Note:
A "PCELL" in this context is not equivalent to the "AREA" term introduced with the release of 
BRAUMAT / SISTAR Classic V6.0, and can be interpreted and configured as a process cell. 
In its simplest context, the process cell covers a complete area.

The names and the units shown in the overview can be customized by users.

3.2.1.1 Determine views
The names of the PCELLs are stored in the file …\windcs\TEXTE.x\BEREICH.TXT. The 
‘Functions > Edit process cell’ command in the menu starts the editor notepad.exe for editing 
the file.

Note:
It is now possible to create a subdirectory on the server for every client (IOS.XXX), in which 
client-specific settings can be stored.
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Example:

 ..\windcs\IOS.021\etc\kpos001.ini

 ..\windcs\IOS.021\texte.0\bereich.txt

As soon as a client directory exists on the server under ...\windcs\..., the settings are read from 
this directory, otherwise the old behavior applies. Through this, the settings can be 
continuously managed/stored centrally on the server. In addition, a Multi-Client automatically 
receives its own settings for every area!

The new process cell names are only valid for the next start of the application.

There are two different methods of building up the files.

Flat structure
Example:

● Raw material acceptance

● Mixing plant

● Filling

● Cleaning

The line position corresponds to the number of the "kpos" file (raw material acceptance -> 
kpos001.ini ... ClP -> kpos004.ini for the example above).

Hierarchical structure
In the file Bereich.txt a hierarchy can be indicated. By entering keywords 'Begin' and 'End' a 
menu structure can be configured. Only leading blanks or tabs may be inserted.

The text following the double slash is only an informative comment and may not be part of the 
code.

Example:
Brewhouse // Title for the main menu Begin // Keyword "Start of submenu" Brewing line1 @1 // 
Text for 1st submenu entry Brewing line2 @2 // Text for 2nd submenu entry End // Keyword 
"End of submenu" Fermenting cellar // Title for the second main menu Begin // Keyword "Start 
of submenu" Vertical tanks1 @10 // Text for 1st submenu entry Vertical tanks2 @11 // Text 
for 2nd submenu entry End // Keyword "End of submenu" 

The @ sign with the following number points to the Kposxxx.ini file there.

Example: @12 is a reference to kpos012.ini.

If no @ sign is inserted, the units (Kposxxx.ini file) are assigned to the areas after the line 
number in the Bereich.txt.

xxx corresponds to the process cell number.
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Example:
Plant // line1 Begin // line2 Plant1 // Kpos003.ini line3 Plant2 @2 // Kpos002.ini line4 End // 
line5

Determine units per area
Up to 64 units can be represented (from different PCUs). 

In the file it is defined which unit is displayed in which line.

xxx corresponds to the line number in "area.txt".

Structure of the files kposxxx.ini:
<Blank>

<PCU Number><blank><unit number>

<PCU Number><blank><unit number>

etc.

Example:
.....empty... 1 1 1 2 1 10 2 1

The entry of PCU-Nr = 0 and TeilAnl-no. = 0 in the file results in a blank on the screen. The 
same unit number can be registered again. 

In the application 'plant overview', it is possible to access the notepad editor for adapting the 
corresponding KPOS file via the menu item 'function' -> 'edit process cell view'. 

The new adjustments are only valid after an area change.

3.2.1.2 Configure message windows
In the type based on S7, a message window can be shown in the lower part of the plant 
overview. In the window, messages relating to the selected sequence are displayed.

File windcs\sys\seqctrl.ini

[Mainwin]ShowMessage=1

 The message window is displayed. (Preset adjustment)

 The message window is displayed.

The column widths of the message window must be moved once to the correct width. The 
adjustment is filed and used by the next start.

3.2.1.3 Setpoints for units
Up to 24 setpoints (DFMs) can be displayed for each unit in the "Sequence related setpoints" 
pane of the process cell overview. This can be configured during equipment engineering in 
the recipe editor. Select the unit, followed by the "Properties" shortcut menu.
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3.2.1.4 Recipe category for the start
The recipe category must be configured in the file windcs\pcu.xxx\recipe\sequence.ini  for 
starting the recipe. If there is no input, no recipe can be started via the application.

[Sequence001] RecType=1,2

More than one recipe category can be displayed. The entries must be separated by comma.

Reduce selection of recipes
For the given recipe category, all recipes are displayed in the recipe selection dialog. This 
selection can be reduced.

For the reduction, the allowed recipes must be engineered behind the recipe category in 
brackets. The following statements are allowed:

● to set single recipe numbers

● to set ranges of recipe numbers

Example:
 [Sequence001] RecType=1(1,2,10-20),2(30-35,40,50-55)

For the recipe category 1, the recipes 1 and 2, as well as the recipe number between 10 and 
20 are allowed. For the recipe category 2, the recipes 30 to 35, the recipe 40 and the recipes 
between 50 and 55 are allowed.

3.2.1.5 Additional unit
The menu item 'Additional unit' can be configured.

This is configured in the file windcs\sys\seqctrl.ini.

[Mainwin]

AddUnitOn=Text 1

AddUnitOff=Text 2

 

3.2.1.6 Enabling step operation
The general step operation must be enabled. A value must be entered in the file 'seqctrl.ini'. 
The value is evaluated in binary form. The value 255 enables all operations.

EOP Start 1
EOP Pause 2
EOP Hold 4
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EOP Stop 8
EOP Abort 16
Leave intermediate state 32

The value is the equivalent of the sum of the individual states to be enabled.

Example: To enable EOP Start and EOP Stop:

Value = 1 + 8 = 9

The calculated value must be entered in "windcs\sys\seqctrl.ini":

[MainWin] 
EOPAdmin=Wert
The "Plant overview" application must be restarted when this value is changed.

 

 Note
Requirements for activating the operating buttons:
● The step operating buttons are only enabled with PCUs as of "Recipe version V5", that 

is, not for S5 control or for S7 control with "Recipe version V3".
● When the enable signals for step operations are value-controlled, the corresponding 

buttons are only enabled when the unit is running and the current status permits step 
control.
For example: Actuation of HOLD enables RESTART and interlocks HOLD.

 

3.2.2 Command line parameter
The application seqctrl.exe can be started by using a command line parameter. The parameter 
indicates the number of the kpos file. With the call a further application is started (see Multi-
instance adjustment (Page 95)).

3.2.3 Multi-instance adjustment
With this adjustment, the application can start only one time. A second start brings the already 
started instance into the foreground.

File: \windcs\sys\seqctrl.ini
Key: [App]
Entry: EnableMultiInst=

EnableMultiInst=0
A started application is set in the foreground. The plant combination is transferred if a 
parameter was sent in the start call.
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EnableMultiInst=1
A further instance of the application is started. If a start parameter was sent the plant 
combination is opened. If no parameter was sent the combination which was opened when 
the application was last closed is opened. 

3.2.4 Configure colors
 

The colors can be configured in the view. The indication is entered as RGB values (red, green, 
blue). Every color value can be between 0 and 255.

The table below shows examples of the RGB values for some of the primary colors.

 Bright Dark
White 255,255,255  
Gray 200,200,200  
Red 255,0,0 125,0,0
Blue 0,0,255 0,0,125
Green 0,255.0 0,125,0
Yellow  255,255,0
Black 0,0,0.  

 

This can be adjusted in the file windcs\sys\seqctrl.ini. under [MainWin].

3.2.4.1 Colors in the window sequencer

TAListFGCol=0,0,0 // foreground color
TAListBGCol=255,255,255 // background color
CursorBGCol=128,128,128 // cursor background color
CursorFGCol=192,0,0 // cursor foreground color
TAFontName=MS Sans Serif // font
TAFontSize=12 // character size
TAListGFGCol=0,0,64 // foreground color just lines
TAListGBGCol=0,64,0 // background color just lines

3.2.4.2 Colors of the status indicator display
The colors of the status indicator can be configured.

StatusAFGCol=255,255,255 // foreground color of the "A" symbol
StatusABGCol=0,0,0 // background color of the "A" symbol
StatusHFGCol=255,255,255 // foreground color of the "H" symbol
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StatusHBGCol=0,0,0 // background color of the "H" symbol
Status-FGCol=255,255,255 // foreground color of the "-" symbol
Status-BGCol=0,0,0 // background color of the "-" symbol
Status+FGCol=255,255,255 // foreground color of the "+" symbol
Status+BGCol=0,0,0 // background color of the "+" symbol
StatusBFGCol=255,255,255 // foreground color of the "B" symbol
StatusBBGCol=0,0,0 // background color of the "B" symbol
StatusSFGCol=255,255,255 // foreground color of the "S" symbol
StatusSBGCol=0,0,0 // background color of the "S" symbol
Status#FGCol=255,255,255 // foreground color of the "#" symbol
Status#BGCol=0,0,0 // background color of the "#" symbol
Status0FGCol=255,255,255 // foreground color of the "0" symbol
Status0BGCol=0,0,0 // background color of the "0" symbol
Status1FGCol=255,255,255 // foreground color of the "1" symbol
Status1BGCol=0,0,0 // background color of the "1" symbol
StatusRFGCol=255,255,255 // foreground color of the "R" symbol
StatusRBGCol=0,0,0 // background color of the "R" symbol
StatusGFGCol=255,255,255 // foreground color of the Sync symbol
StatusGBGCol=0,0,0 // background color of the Sync symbol
Status_FGCol=255,255,255 // foreground color of the Alternative symbol
Status_BGCol=0,0,0 // background color of the Alternative symbol
StatusEFGCol=255,255,255 // foreground color of the Error symbol
StatusEBGCol=0,0,0 // background color of the Error symbol
StatusPFGCol=255,255,255 // foreground color of the Process symbol
StatusPBGCol=0,0,0 // background color of the process symbol
StatusCFGCol=255,255,255 // foreground color of the RCS symbol
StatusCBGCol=0,0,0 // background color of the RCS symbol

3.2.4.3 Colors of the setpoint/process values column
The colors of the setpoint/process value can be configured.

SollFGCol=100,80,200 // foreground color of the setpoint column
IstFGCol=200,80,100 // foreground color of the process value column
SPListFontName=MS Sans Serif // font
SPListFontSize=12 // character size
SollFGCol=0,0,192 // reference value type color
SollGBGCol=0,192,0 // reference value background even lines
SollUBGCol=192,0,0 // reference value background odd lines
IstFGCol=0,0,64 // process value type color
IstGBGCol=0,64,0 // process value background even lines
IstUBGCol=64,0,0 // process value background odd lines
SWGBGCol=64,64,0 // setpoint window background even lines
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SWGFGCol=0,64,64 // setpoint window document even lines
SWUBGCol=192,192,0 // setpoint window background odd lines
SWUFGCol=0,192,192 // setpoint window document odd lines
SWDefaultBGCol=200,200,200 // setpoint window background color preset

3.3 View
 

3.3.1 Format
The view is divided into four regions:

● Viewing section for units

● Display section for unit-related setpoints

● Display section for step-related setpoints and corresponding current process values.

● Display section for unit-related messages (only reasonable in the type based on S7)
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3.3.2 Viewing section for units
 

Column 1: No.
Number of units. Adding empty lines (blanks) is possible.
Column 2: Sequence (Unit)
Indication of the symbolic unit name with a maximum of 16 ASCII characters. The unit name is allocated with the text 
parameterization.
Column 3: 'Seq.Status'
Column 4: 'Display'

 See also:  Status indicators
Column 5: Step
Numeric signaling of the currently active step of the corresponding unit.
Column 6: EOP
Signaling the number of active technical operations (TOP) with index.
Column 7: EOP Name
Text for the equipment operation with a maximum of 16 ASCII characters as description of the basic operation which is 
currently working.
Column 8: EOP Status
Current status of the technical operation.
Column 9: Time
Display of the actual value of the step time.
Column 10: Recipe
Signaling of the current recipe name with a maximum of 16 ASCII characters.
Column 11: Batch
Signaling the current batch number.
Column 12: Order number
Signaling the current order number.

3.3.2.1 Status indicators
Indications for usage are displayed as a current status of the individual units.

A or M A = unit is in the automatic mode
M = unit is in the manual mode

+ or - + = switch to next step after actual step is finished
- = sequence is stopped after the current step is finished.

#, = or _ '#' = Permanent condition for this step is missing; '=' = Unit on hold at a 
synchronization point
'_' = Unit on hold at an alternative point; otherwise a blank is displayed

0 or 1 The user flag of the unit is active or inactive
O (flashing) For this unit an operation request is necessary
S (flashing) The unit is erroneous.
R (flashing) Recipe load error (e.g. the unit recipe is missing)

Plant Overview
3.3 View

Operator control and monitoring of batches
Function Manual, 11/2012, A5E00239386-09 99



E (flashing) An error message was generated for this unit.
W (flashing) A warning was generated for this unit.
M A message was generated for this unit.

3.3.3 Multi-client function
When you start an application on a client that is configured for operation in a multiclient 
architecture, the view selection dialog box opens, showing the enabled views. After you have 
selected a view, the current instance of the control recipe visualization is automatically linked 
to this view. This view assignment is maintained throughout the life cycle of this instance.

To access further areas, an additional instance of the plant overview is started. Visualization 
in other views is not possible in one instance of the control recipe visualization!

3.3.4 Sequencer setpoints and process values
The actual setpoint and process values for the 13 parameters of the currently selected 
sequence are visualized in a separate setpoint/process value window.

Sequencer setpoints are configured in "sequence.ini".

 See also:  Setpoints for units

You can edit the setpoint column directly in the window. To edit text-based setpoints, a separate 
dialog box is opened when you select a setpoint cell.

Columns displayed:

● Name (name of the DFM)

● Dimensions

● Setpoint

● Actual value

● Delta (= setpoint – process value)

.

3.3.5 Step-related setpoints
In the window, the step-related setpoints of the running step are displayed and these can be 
changed. 

As a first setpoint, the step running time is indicated.

Otherwise, the same is valid for the input and the view as for the setpoint and process values 
of the unit.

 See also:  Sequencer setpoints and process values
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3.3.6 Working with the application

3.3.6.1 Displaying unit data
The units are plant-related. With an area-crossed operation, the plant that needs to be operated 
can be selected by the menu Process Cell. A mixed signaling of units of several areas is 
possible (see Kposxxx.ini). The units of the selected process cell can be operated.

The "sequencer setpoints" can be hidden by setting a switch in seqctrl.ini. The default is 
ShowNotWhenRunning=0, i.e. the setpoints are shown. 

Hiding the setpoints

;Hide the sequencer-setpoints of a running sequence

ShowNotWhenRunning=1

This status is indicated by the message "Sequence running, setpoints are hidden!"

3.3.6.2 Show only running sequencers
The operator control button "Active sequences only" in the application toolbar can be used to 
hide inactive sequences. Same as with sequencer setpoints, this function can be enabled in 
order to save variables when using S5 PCUs. Add the following entry to Seqctrl.ini in the windcs
\sys  folder:

[SaveAGVar]
EnableShowRunningSeqs=0
The default value of this switch is "1", i.e. the operator control button is enabled.

3.3.6.3 View description
The meaning of the individual parts of the view is described under 'format' (Chap. "Format 
(Page 98)").

The display of the units is in blocks of a maximum of 16 units. However, it is possible to page 
back and forth line- and page-wise with the cursor keys. The selected unit is marked in color. 
The setpoints and process values are displayed for the currently selected unit in the lower 
operating area. It is also possible to select the unit by clicking the unit name with the mouse.

3.3.6.4 Selection of the process cell
For a plant-crossed operation the system which needs to be operated can be selected via the 
menu 'Anlage' 'process cell'. The displayed data and manual operations of units refer 
exclusively to the selected process cell.

3.3.6.5 Selection of the unit
The colored background of the unit name indicates the currently selected unit.

There are two possibilities for selecting the unit:
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● Cursor keys

● Click the unit names with the mouse

3.3.6.6 Selection of a sequence step
The sequence step is selected in 3 steps:

● Selection of the requested unit and clicking the icon 'step'  in the toolbar

● Selection of the requested unit. After that the menu 'function' is selected via the menu item 
'step'.

● Click the column 'step' for the requested unit with the mouse. The selection of the unit 
follows automatically after that.

The dialog box 'step selection' follows. This sets the 'plant overview' application to the waiting 
state (model dialog) as long as the operation with the input of one value between 0 and 255 
and return is closed.

With the dialog box the current step is displayed. This can be confirmed by a return or 
overwritten by entering a different value and return. When entering a negative value the plant 
overview message box appears with the note "Value too small!"; with the input of a value more 
than 255 the input message box "Value too large!" appears. If you do not enter a number, the 
Plant overview message box pops up the with the information: "Please enter an integer number!
“. Both message boxes are modal and must be operated with the OK confirmation. The cursor 
is in the input field of the step selection again, and the primary value is displayed. After a 
successful step selection the entered value appears in the step column of the selected unit.

The input of the value "0" causes a stop of the unit. With the input of the value "1" the unit is 
started. It is also possible to start the unit via the menu item 'Start sequence' in the menu 
'functions'. With a standing unit (Step 0) the input of recipe and batch is possible.

3.3.6.7 Selection of the recipe, order and batch number
The selection is only possible if the corresponding unit is not started (current step 0). The 
selection can take place in several ways:

● Selection of the requested unit. After that the menu 'function' is selected via the menu item 
'step'..

● Click the column 'Recipe' 'Batch' or 'OrderID' for the requested unit with the mouse. The 
selection of the unit follows automatically after that.

The dialog box 'recipe select' follows. This sets the application 'plant overview' in holding 
position until the operation is confirmed with OK or abort.
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3.3.6.8 Dialog 'Recipe selection'
The indication 'recipe selection' for the recipe, order and batch number are preset via a dialog. 

Recipe category
The recipe categories to be displayed must be configured in the file 'sequence.ini'. 

 See also:  Recipe category for the start 

Batch
Input fields for the order and batch number.

Recipe
Signaling recipes for the selected recipe category.

OK
The values are accepted and transmitted to the SIMATIC.

3.3.6.9 Input of setpoints
The displayed setpoints and actual values of up to 13 step parameters in the parameter window 
always refer to the current step of the selected unit. After the continuation to the next step or 
after the selection of another unit the setpoints and actual values are updated automatically. 
In addition, the actual values are updated automatically during the processing of a step. The 
setpoints are accepted from the corresponding recipe; the actual values come from the process 
directly.

The setpoints for a sequence step can always be changed. However, the change is only 
effective for this individual step; no parameter transfer occurs in the corresponding recipe.
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For the input of setpoints the following operation is necessary:

● Move the cursor with the mouse into the corresponding input field of the setpoints and click 
on the field. The current value in the field is selected.

● It is possible to change to different input fields with the mouse.

● The high and low limits for setpoint input are monitored. Values are only accepted if they 
lie within range.

● The setpoint value input is closed with the return key.

3.3.6.10 Start a sequence
The start of a unit occurs 

● via the 'Start' menu item of the menu 'Functions',

● with the input of step 1 for the corresponding unit (no further dialog is shown)

● or by clicking the start icon  in the button bar.

Before the start of the sequence, a dialog which indicates the current order and batch number 
and the selected recipe is displayed.

After the start, the corresponding setpoints are fetched from the recipe list for every step and 
displayed in the unit parameter window.

Dialog

Recipe category
The recipe categories to be displayed must be configured in the file sequence.ini. 

 See also:  Recipe category for the start 
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Batch
Input fields for the order and batch number.

Recipe
Signaling recipes for the selected recipe category.

Start
The values are accepted and transmitted to the SIMATIC. The sequence is started.

3.3.6.11 Aborting a sequence
The unit can be aborted at any time 

● via the menu item 'Sequence stop' in the menu 'functions',

● with the input of step 0 for the corresponding unit

● or by clicking the icon  'Sequence stop' in the button bar.

3.3.6.12 Enable step switchover
The automatic incrementing into the next step of the current unit can be enabled with the 
operating mode selection "+":

● Menu item 'enabling' in the menu 'functions'

● Click the icon 'enabling' in the button bar

The unit is held after closing any step by the operation type selection:

● Menu item 'Hold sequence' in the menu functions

● Click the icons 'Hold sequence' in the button bar

3.3.6.13 Errors of a unit
An error in the unit is displayed by a flashing red S in the column 'status indicators' of the 
corresponding unit. In the event of an error a horn can be controlled, the signal for which is 
acknowledged with the symbol bar icon 'acknowledge horn' or with F12.

Errors in units can have the following causes:

● The monitoring time expires without reaching the requested setpoint.

● The monitoring time expires and the step enabling condition for the next step is missing 
(e.g. acknowledgments).

● The monitoring time expires and the sequencer is in stop mode.

After removing errors, the unit can be started with the next step or the unit switches 
automatically to the next step.
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The sequence steps of a unit can be continued in spite of present errors. You continue to the 
next step of the unit via the manual step selection. In this way it is possible to avoid errors in 
the unit. The user must be aware of the possible effects.

3.3.6.14 Additional flag On/Off
This function enables a data bit to be set and reset in the data record of the unit that is user-
defined.

The name of the menu item can be configured.

 See also:  Additional unit

3.3.6.15 Acknowledgment of user request
Active operator requests marked by a flashing 'O' in the column 'status indicators' can be 
acknowledged 

● with the menu item 'Acknowledge->User acknowledge'

● by using the function key F8

● or by clicking the icon Quit   in the button bar.

Operation request dialog
After activating the button, a dialog is displayed. 

The display of the dialog can be suppressed (V4 compatibility behavior). 

File: winds\sys\seqctrl.ini
Key: [OpReq]
Entry: OpReqV4=0
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Operating request with value input
The operating request can also be submitted with a value input.

 See also:  Recipe system Configuration of the plant data

File: windcs\pcu.xxx\recipe\epe.ini

[EPE###] ### number of the technical operation 

Trailer OpReq=Check 

OpReqFlags=4112

● with value input
Value: 4112 = 4096 +16

● without value input
Value: 4096

3.3.6.16 Viewing active operator requests
Active operator requests are marked by a flashing 'O' in the column 'status indicators'. 
Additionally, an engineered text is shown in the toolbar. 

 See also:  Recipe system Configuration of the plant data

3.3.6.17 Further acknowledgment functions
These functions are only relevant for the type based on S7.

 See also: Messages

Acknowledgment includes:
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● Errors

● Warnings

● Process messages

ICM errors are acknowledged by clicking the icon 'ICM'  in the button bar or by pressing 
'F11'. The acknowledgment refers to all pending ICM errors of the operation area.

3.3.6.18 Sequence-related message window
The pending errors, warnings and process messages are removed from the view by activating 
the corresponding buttons in the button bar.

Remove messages which are configured as message class 'Error'

Remove messages which are configured as message class 'Warning'

Remove messages which are configured as message class 'Process messages'

 See also:  Messages  Message classes and sequence overview

3.3.6.19 Note function
Open a text editor for entering a note by the user. The text can be changed, added and filed 
in any way.

● The note is processed via the Windows editor.

● A note for the unit or a note for the current recipe can be written or called by the user.

● The recipe note is selected via the 'recipe note' menu item in the menu 'functions' or via 
the function keys 'Shift+F10'.

● The note for the unit is selected via the menu item 'note' in the menu 'functions' or via the 
function key 'F10'.

3.3.6.20 Selection unit process images
Process images of the individual units can be selected directly by the menu item 'unit process 
figure' in the menu 'program' or via the function key 'F2'. The process figure which is associated 
with the selected unit is displayed.

Check your configuration if the message "Image not found" appears. The image names for all 
64 units are stored in the file "Windcs\pcu.xxx\texte.0\kettbld.txt".

Example:
● BteilAnl01.bik

● BteilAnl02.bik

● BteilAnl03.bik
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The image files have to be stored in the folder "...\windcs\bilder\...".

3.3.6.21 Selection Status
The status of the current unit is displayed after the call of the menu item 'status' in the menu 
'program' or via the function key 'F4'.

When the unit is not running, the system displays corresponding permanent conditions in 
FB1001 to FB 1064.

When the unit is running, the system displays Network 1 of the currently active EOP (FC1001 
to FC1999).

The following message box indicates that the block was not found in the controls

For information on the application status:

 See also: Applications based on S7.

3.3.6.22 Status of start and permanent condition
The permanent condition of the current unit is displayed after calling the 'start and permanent 
condition' in the 'program menu' or via the function key Shift+F4.

The system shows the permanent condition in FB1001 to 1064, depending on the unit.

For information on the application status:

 See also: Applications based on S7.

3.3.6.23 Selection Status step on condition
The permanent condition of the current unit is displayed after calling the 'start and permanent 
condition' in the 'program menu' or via the function key Shift+F4.

When the unit is not running, the system displays corresponding permanent conditions in 
FB1001 to FB 1064.

When the unit is running, the system displays Network 5 of the currently active EOP (FC1001 
to FC1999).

For information on the application status:

  See also: Applications based on S7.
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3.3.6.24 Selection of the application "DFM overview"
An overview of all DFMs of the current unit is displayed via the 'DFM overview' in the menu 
program or via the function key 'Shift+F8'.

3.3.6.25 Selection diagnosis of the routes
The diagnosis function of the route control for the current unit can be called directly via the 
menu item 'route' in the menu 'program' or via the function key 'Alt+F8'.

3.3.6.26 Selection batch list
Via the menu item 'batch list' in the menu 'program' or via the function key 'Ctrl+F8' the batch 
list is called for the current unit.

3.3.6.27 Show control recipe
Via the key 'F9' the actual control recipe of the batch of the selected sequence is opened.

Via the key 'CTRL + F9' the control recipe data block of the PCU is opened (Control recipe 
PCU) and the control recipe unit procedure is shown in the list view.

3.3.6.28 Selection 'Edit process cell'
Via the menu item 'edit process cell' under 'functions' you reach an ASCII editor with a loaded 
file "Area.txt". The individual unit areas are entered here.

3.3.6.29 Selection 'Edit process cell view'
Via the menu item 'edit process cell' under 'functions' you reach an ASCII editor with a loaded 
file "KPOSxxx.txt". Here, the units which are part of one area are entered whereby "xxx" 
corresponds to the area number. 
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Units faceplate 4
4.1 General

To facilitate operator control of units, the UNIT Control faceplate can be used in process 
pictures. You can find a description of this function in the following manuals:

● Engineering: Manual titled "Operator control and monitoring based on S7", section: Image 
design/Faceplates/Unit Control faceplate

● Operation/runtime views: Manual titled "Operator control and monitoring based on S7", 
section: Runtime system/Faceplates/Unit Control faceplate
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Control recipe display 5
5.1 System-relevant properties

The function for the visualization of control recipes does not archive data of expired batches. 
This archiving function is covered by the step protocol functions. For reasons found in the 
architecture and utilization of the system, integration of the control recipe display function in 
the recipe process is based on sourcing methods, instead of using the PCU datagrams as in 
the step protocols. For this reason, it may seem that a step is skipped when the system is 
operating at higher step rates and when certain steps are performed (Start EOP and End EOP). 
In this case, the step protocol provides reliable offline information on all processed operations.

5.2 Short description
The task of the control recipe visualization function is to visualize the processing steps of 
control recipes which were generated by the recipe system and downloaded to the PCU. Based 
on the recipe procedures, the recipe system generates the control recipes by substituting the 
process/order parameters with the current master recipe/order parameters. When the recipe 
procedure contains weighing recipe operations, the control recipe dynamically generates 
weighing and interim draining operations, depending on the volume of process input materials 
to be weighed. The completed control recipes are then downloaded as unit recipes for 
processing on the relevant PCUs.

5.3 Starting control recipe visualization

5.3.1 Multi-client function
When you start an application on a client that is configured for operation in a multiclient 
architecture, the view selection dialog box opens, showing the enabled views. After you have 
selected a view, the current instance of the control recipe visualization is automatically linked 
to this view. This view assignment is maintained throughout the life cycle of this instance.

Visualization in other views is not possible in one instance of the control recipe visualization!

5.3.2 Multiple-instance capability and number of concurrently monitored control recipes
In contrast to other BRAUMAT/SISTAR Classic V6.0 applications and for reasons of load on 
resources, it is not possible to visualize multiple instances of a recipe control simultaneously. 
This also applies to the multiclient mode of a Braumat station. Operators who want to monitor 
control recipes located in the inactive area of the current control recipe visualization must 
restart the application and then select the relevant view from the area selection dialog box.
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5.4 Overview – Views of the control recipe visualization

Currently active recipes are visualized in the control recipe view in two different modes. The 
program can generate the structure of a control recipe, based on the offline recipe 
configuration, and it can visualize a batch process in this control recipe structure, based on 
the unit image it fetches from the PCU server. The graphic view of the control recipes serves 
this purpose. The step and sequencer reference values, such as the setpoint for the step 
monitoring time, can be modified in the setpoint list windows of the graphic control recipe view.

The control recipe view can also fetch the current recipe DB from the automation device and 
visualize it as unit procedure control recipe. In this visualization mode, the operator can modify 
the setpoint values and monitoring times of the unit recipe, and then perform a delta download 
to the automation device.

The batch overview shows all active batches, sorted in a group according to their order type 
and number, and it is used to select a control recipe for visualization in the graphic view.
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5.5 Operator control elements common for all views

5.5.1 Menu commands

Program
● This menu area is filled according to the entries in "Menuappl.ini".

Batches
● Update Refreshes the structure view of the batch overview, and removes expired batches 

(status = "Done") from the list

● Fetch TRP from PCU Fetches the current unit recipe from the PCU. When the batch 
overview is active, the system shows a dialog window for selecting the sequence. When 
the graphic control recipe view is active, the system loads the recipe unit procedure which 
is indicated in the column at the cursor position.

● Order parameters Opens the order parameters list of the batch that is selected from the 
batch overview or opened in the graphic view. This menu item is disabled if you have not 
selected a batch in the batch overview.

● Process input Opens the process input list of the batch that is selected from the batch 
overview or opened in the graphic view. This menu item is disabled if you have not selected 
a batch in the batch overview.

● Close Closes the control recipe view.

Window
● Cascade

● Tile horizontally

● Tile vertically Arranges the opened and not maximized windows accordingly.

Help
● System Opens the system Online Help.

● System index Opens the index of the system Online Help.

● Control recipe Opens the Online Help for the control recipe view.

● Control recipe index Opens the index of the Online Help for the control recipe view.

● About Opens a dialog that shows Copyright and Version information.
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5.5.2 Dialog boxes used in all views

5.5.2.1 Toolbar buttons used in all views

Exit program. Closes the control recipe view

Acknowledge ICM errors

Acknowledge audible messages

Reset password immediately

Download recipe unit procedure from PCU

This toolbar button is assigned various functions, depending on which window is currently 
active in the control recipe view: When the batch overview is active, the function opens a 
sequence selection dialog window for selecting the sequence (= recipe DB) of which the recipe 
unit procedure is to be read. When the graphic view is active, the sequence is determined by 
the cursor position, i.e. the function reads the recipe unit procedure of the sequence on which 
the cursor is positioned.
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5.5.2.2 'Order parameters' dialog box

You can open this dialog box by calling the "Batch/order parameters" command in the batch 
overview and in the graphic control recipe view, or the "Order parameters" shortcut command 
for a batch in the batch structure view.

Order parameters list
The order parameters of an inactive batch can be modified in the values column of the order 
parameters list. The dialog box is used for monitoring the order parameters of active batches. 
However, users can explicitly enable CIR for the order parameters of an active batch. This is 
done by setting the switch "ChangeRunningBatches" in section "Settings" of the file "windcs
\sys\baliedit.ini" to the value "1".

Min. and Max.
The two read-only text boxes show the minimum and maximum values of the selected order 
parameter.
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Apply
Downloads the modified order parameters to the PCU.

Close order parameters list
This dialog box is closed either by pressing the RETURN key or by clicking the exit button ("x") 
on the upper right.

5.5.2.3 'Process input list' dialog box
Shows the process input list for the selected batch.

The error message "Could not open batch process input list!" is output instead of the dialog 
box when a request to read the batch process input list fails, or an attempt is made to open a 
process input list, which does not contain weighing procedures.

The control recipe visualization program utilizes the batch process input list for the purpose of 
monitoring. The process input list cannot be modified in this application.

Print
Opens the standard Windows® printer dialog box, and outputs the batch process input list to 
the printer.

OK
Closes the dialog box.
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Cancel
Closes the dialog box

5.6 Batch overview
 

The batch overview represents the primary view of the control recipe visualization program. It 
opens immediately after the application has started and cannot be closed. This tree structure 
shows all active batches, sorted by their order types and orders. The control recipe visualization 
program does not access system archives, and does not provide internal batch history data. 
Hence, the application shows only the batches which are in the "locked", "ready" or "started" 
state. The program shows all states of the batches opened in the structure view while the 
control recipe view is active, i.e. it also indicates the status transition to "done". However, 
batches which have acquired the "done" status are deleted from the structure when the batch 
overview is updated.
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5.6.1 Symbols of the structure view
The icons shown in the table below are used to indicate the batch status and the structure in 
the overview.

Icon Meaning
Root element of the Batch overview, "Current batches"

Order type

Order

Batch in state "Locked"

Batch in state "Able to start"

Batch in state "Released"

Batch in state "Started"

Batch in state "Released"

5.6.2 Menu commands of the batch overview
In addition to the menu commands which are available in all views, a shortcut menu is provided 
for the batches in the structure view (open with right-click). The commands are:

Batch shortcut menu
● Open control recipe

Opens the graphic view of control recipes
 See also:  Chap. "Graphic view of control recipes (Page 122)"

● Order parameters
Shows the order parameters list of the selected batch.

 See also:  Chap. "'Order parameters' dialog box (Page 117)"

● Process input list
Shows the process input list for the selected batch.

 See also:  Chap. "'Process input list' dialog box (Page 118)"
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5.6.3 Batch overview dialog boxes

5.6.3.1 'Sequence selection' dialog box
Before you can upload a control recipe list from the PCU by means of the batch overview, you 
need to select a sequence from the "Sequence selection" dialog box in order to determine 
which recipe DB the system has to fetch.

Structure view of the plant overview
Provides a system component tree and is used to select a sequence. The system reads the 
recipe unit procedure of the sequence from the corresponding PCU, and interprets and 
visualizes it in a list.

Properties list
Improves orientation by showing a list of the system components.

Close
Closes the dialog box, without selecting a recipe unit procedure.

Apply
Closes the dialog box and reads the selected recipe unit procedure from the PCU. This button 
is only enabled when a sequence is selected.
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5.7 Graphic view of control recipes

5.7.1 Title bar information
The title bar of the window, or of the application with maximized window, shows the name of 
the recipe category, the order year and the order/batch number.

5.7.2 Toolbar commands

User-specific zoom  

Allows the user to set the zoom factor. In the graphic recipe procedure, the operator can hold down 
the left mouse button to mark an area, and then drag it to the full size of the window.

Zoom in  

Increases the zoom factor by one step.
Zoom out  

Decreases the zoom factor by one step.

  

5.7.3 User interfaces of the graphic control recipe view
The "Recipe procedure overview" and "Recipe tree" windows are a navigation tool,  which the 
user can switch on and off, dock onto other windows, and use for quick navigation and 
orientation in complex recipe procedure structures. In contrast to the navigation tools of the 
recipe editor, data in the windows of the graphic control recipe view are read-only and thus 
cannot be edited.

 See also:  Recipe system  The recipe procedure views/windows

In contrast to the recipe editor, the graphic recipe procedure view of the control recipe view 
contains a setpoint window, which can be docked and switched on and off. 

5.7.4 Graphic recipe procedure view

5.7.4.1 Status indication
The processing states of technical operations are indicated in the graphic control recipe view 
by means of configurable character/background colors, and using the icons next to the 
operations.
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Color settings
The colors of the graphic control recipe view can be customized to suit user requirements in 
"windcs\recipe\project\plant.ini". If the user does not write data to this file or deletes data, the 
system uses the default values shown in the table below.

The colors are coded according to the RGB model, i.e. the color scheme is an additive 
generated from the red, green and blue element. The intensity of an element is described by 
a value between 0 (no color) and 255 (maximum of the element). Thus, "0,0,0" black, "255, 
255, 255" white, "255, 255, 0" yellow, "255, 0, 255" violet and "0, 255, 255" turquoise.

The following table lists all entries and the accompanying default values:

Section Entry Standard RGB value Comment
Grafic-Onl StdBk 255, 255, 255 Background color of the 

drawing area
Grafic-Onl GopColorStd 0, 0, 0 Standard character color for 

foreground
Grafic-Onl GopColorStdBk 255, 255, 255 Standard character color for 

background
Grafic-Onl GopColorIdle 0, 0, 0 Color of characters in "Idle" 

state
Grafic-Onl GopColorIdleBk 255, 255, 255 Background color in "Idle" 

state
Grafic-Onl GopColorRunning 0, 0, 128 Character color in 

"Running" state
Grafic-Onl GopColorRunningBk 0, 255, 0 Background color in 

"Running" state
Grafic-Onl GopColorStarting 0, 0, 0 Character color in "Starting" 

state
Grafic-Onl GopColorStartingBk 228, 128, 32 Background color in 

"Starting" state
Grafic-Onl GopColorRestarting 0, 0, 0 Character color in 

"Restarting" state 1)
Grafic-Onl GopColorRestartingBk 228, 128, 32 Background color in 

"Restarting" state
Grafic-Onl GopColorPaused 0, 0, 0 Character color in "Paused" 

state
Grafic-Onl GopColorPausedBk 32, 128, 128 Background color in 

"Paused" state
Grafic-Onl GopColorPausing 0, 0, 0 Character color in 

"Pausing" state
Grafic-Onl GopColorPausingBk 32, 128, 128 Background color in 

"Pausing" state
Grafic-Onl GopColorHeld 0, 0, 0 Character color in "Held" 

state
Grafic-Onl GopColorHeldBk 255, 255, 0 Background color in "Held" 

state
Grafic-Onl GopColorHolding 0, 0, 0 Character color in "Holding" 

state
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Section Entry Standard RGB value Comment
Grafic-Onl GopColorHoldingBk 255, 255, 0 Background color in 

"Holding" state
Grafic-Onl GopColorAborted 0, 0, 0 Character color in "Aborted" 

state
Grafic-Onl GopColorAbortedBk 128, 255, 128 Background color in 

"Aborted" state
Grafic-Onl GopColorAborting 0, 0, 0 Character color in 

"Aborting" state
Grafic-Onl GopColorAbortingBk 0, 255, 0 Background color in 

"Aborting" state
Grafic-Onl GopColorStopped 0, 0, 0 Character color in 

"Stopped" state
Grafic-Onl GopColorStoppedBk 128, 255, 128 Background color in 

"Stopped" state
Grafic-Onl GopColorStopping 0,0,0 Character color in 

"Stopping" state
Grafic-Onl GopColorStoppingBk 0,255,0 Background color in 

"Stopping" state
Grafic-Onl GopColorComplete 0,0,0 Character color in 

"Complete"
Grafic-Onl GopColorCompleteBk 128,255,128 Background color in 

"Complete" state
Grafic-Onl GopColorOpReq 0,0,0 Character color for queued 

operator request
Grafic-Onl GopColorOpReqBk 0,255,0 Background color for 

queued operator request
Grafic-Onl GopColorTimeOut 0,0,0 Character color for timeout
Grafic-Onl GopColorTimeOutBk 0,255,0 Background for timeout
1) Comment: The gross Anglicism "restarting" originates from the standard DIN EN 61512-1 (German 
translation of the ISA-S88.01-1995), which is however, unvindicated.

Status icons
The actual state of the operations is shown on the graphic recipe procedure view by means 
of a symbol on the right beside the operation.

Icon Status
No icon Idle

Running

Starting

Restarting
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Icon Status
Paused

Pausing

Held

Holding

Aborted

Aborting

Stopped

Stopping

Complete

Queued operator request

Timeout

5.7.5 Recipe procedure overview
 See  Recipe system  The recipe procedure views/windows/recipe procedure overview

5.7.6 Recipe procedure hierarchy
 See also: Recipe system 
 The recipe procedure view/windows/recipe procedure hierarchy

The recipe procedure hierarchy of the control recipe view is read-only, in contrast to the recipe 
procedure hierarchy in the recipe editor.
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5.7.7 Setpoint/process value window
 

The graphic recipe procedure view has a setpoint/process value window in which the setpoint 
and process values of the sequence are shown in the left half and the setpoint and process 
values of the steps are shown in the right half.

5.7.7.1 Sequencer setpoints and process values
The actual setpoint and process values for the 13 parameters of the currently selected 
sequence are visualized in a separate setpoint/process value window.

Sequencer setpoints are configured in "sequence.ini".

 See also:  Setpoints for units

The first position in the list of sequencer setpoints shows the step monitoring time of the active 
step of the sequence, followed by the sequencer setpoints/process values. The setpoints/
process values are hidden when the cursor is positioned in the column of an inactive sequence. 
After the sequence is completed, the window shows the step monitoring time setpoint/process 
value of the step which was last executed.

You can edit the setpoint column directly in the window. To edit text-based setpoints, a separate 
dialog box is opened when you select a setpoint cell.

Columns displayed:

● Name (name of the DFM)

● Dimensions

● Setpoint

● Actual value

● Delta (= setpoint – process value)

.

5.7.7.2 Step-related setpoints
The step setpoints list shows the setpoints and process values of the DFM when the step is 
active, and the setpoints of the recipe DB when the step is inactive. This difference is indicated 
by the list header. The text "[DFM]" is appended to the setpoint and process values of the DFM, 
otherwise the text "[recipe]".

Input and visualization is handled in the the same way as for the sequencer setpoints and 
process values.

 See also:  Sequencer setpoints and process values

5.7.7.3 Visualization of setpoints in the "Tooltip" window of the graphic tree view
The "Tooltip" window of the graphic control recipe view always shows the offline recipe 
setpoints in the step Tooltip.
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5.8 Recipe unit procedures list
 

The recipe unit procedures list is read online from the PCU, and represents a recipe unit 
procedure in the form of a unit control list for one sequence. Setpoints and step monitoring 
times can be modified in the recipe unit procedures list, and can be written back to the PCU 
by means of the toolbar/menu command "Write RUP list to PCU".

5.8.1 Title bar information
The following information is shown in the title bar of the recipe unit procedure window, or, when 
the window is maximized, in the title bar of the control recipe view: 

● Name of the sequence

● PCU number

● PCU name

● Name of the master recipe

● Order number

● Batch number

.
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5.8.2 Toolbar commands
Write RUP list to PCU Downloads the recipe unit procedure which was modified in the 
control recipe view to the PCU.

5.8.3 Menu commands

Batches
● Write RUP list to PCU        Downloads the recipe unit procedure which was modified in the 

control recipe view to the PCU.

5.8.4 Recipe unit procedure list
Special operations such as "Synchronization" or "Alternative" are shown in the list window of 
the recipe editor.

 See also: Recipe system The recipe procedure views/windows/recipe unit procedure 
list

In this list you can modify only the setpoints and monitoring times. The recipe structure is read-
only. Setpoints can neither be substituted with order or process parameters, nor can they be 
scaled.
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Batch operation diagnosis 6
6.1 Application
 

For the diagnosis of the recipe control in the recipe server there is the recipe control application 
'Diagnosis recipe control' (reccontr.exe).

In this application the status of synchronizations and alternatives can be queried.

Under the menu 'file', there is the selection of synchronizations and alternatives.

Every synchronization or alternative is marked by the year, the recipe category, the order and 
batch number and the synchronization number.

6.1.1 Synchronizations
Dialog selection: File\Synchronization\OK Button
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Synchronization
Here, the data of the synchronization is displayed.

Waiting for units AND
Here the units are listed on which AND is waited for. 'OK ' or 'WAIT' can be found behind the 
unit

● OK: Unit is already at the synchronization

● WAIT: Unit hasn't already reached synchronization

Activating sequences
Here, the units are listed which are supposed to be started with the synchronization

● OK: Unit is ready to start

● WAIT: Unit is occupied, is set to hand, hold or the permanent condition is missing

Waiting for units OR
Here, the units on which OR is waited for are listed. 'OK ' or 'WAIT' can be found behind the 
unit

● OK: Unit is already at the synchronization

● WAIT: Unit hasn't already reached synchronization

Button 'RUP OK +'
With this button the status of a unit can be set for the synchronization to OK . A following unit 
telegram overwrites the status.

Button 'RUP Not OK'
With this button the status of a unit can be set for the synchronization on Wait. A following unit 
telegram overwrites the status.

Delete
With the button the synchronization can be deleted. Following unit telegrams create the 
synchronization again.

Reset error state
With the button, the current error status of the synchronization is deleted.
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6.1.2 Alternatives

Alternative
Here the data of the alternative are displayed.

The meaning of the buttons is the same as the synchronization.

6.2 PCU Server

6.2.1 PCU Server
On the active recipe server, a diagnosis window can be opened via the menu item 'Options'-
>'Recipe control' in the application PCU server.

Via the button '>>>', an expanded representation can be opened.
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6.2.2 FIFO allocation
In the view, the FIFO-allocation is displayed to all PCUs.
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6.2.3 Sequence image
In this window (TAs), all sequences of all PCUs are displayed.

The views correspond to a large extent to the signaling in the plant overview. The data are 
transmitted via the telegram type 13 of the SIMATIC.

Update
The view is built up from the sequencer image again.

Request
Data for the selected sequence are newly requested by the SIMATIC.

General request
Data of all sequences are newly requested by the SIMATIC controls.
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6.2.4 Recipe control diagnosis

In the window (RecCtrl), diagnosis messages relating to the server startup and the recipe 
control are output.

Level
The messages are grouped with a different level. It is determined, which messages are 
displayed by the indication. 

● With level 100, all messages are displayed.

● With level 0, no messages are displayed.

● Start messages have the level 5

● Error reports have the level 10

● Repairable errors have the level 20

● above this limit, there are information and other messages

Trace Off
With this the trace output can be disabled.
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Clear
With this, the window can be deleted.

6.2.5 Recipe load function

In this window (RecLoad), messages relating to the loading of control recipes into the SIMATIC 
are displayed.

This window provides diagnostic information with recipe load errors of the sequencers.

The following commands can only be set after one line is selected with the mouse.

Level
With Ctrl + and Ctrl – the level of the signaling can be changed.

Clear
With Ctrl + C the signaling can be deleted.
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On/Off trace
With Ctrl + T the trace function can be switched on/off.

6.2.6 Order system

In this window (BaliData), messages relating to the Runtime part of the order system are 
displayed.

Level
With Ctrl + and Ctrl – the level of the signaling can be changed.

Clear
With Ctrl + C the signaling can be deleted.

On/Off trace
With Ctrl + T the trace function can be switched on/off.
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Writing on file
With Ctrl +F messages can be written into a file.
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What to do with errors? 7
7.1 Overview

No Error What to do
1 A sequence indicates recipe load errors. Opening the recipe control diagnosis window on the active 

'recipe server'. There, it is indicated why the recipe requested 
from the sequence could not be loaded.
See 'Recipe load function'
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